Canon CEm [

RAW Image Processing, Viewing and Editing Software Contents
Digital Photo Professional e

Ver. 4.5 . I

arises.

Instruction Manual "
orting
Images
Editing
Images
S Printing
Content of this Instruction Manual =< : Marks tips for using the software skillfully. Images
DPP stands for Digital Photo Professional. ® : Marks information that should be read .
. _ before use. Processing
» indicates the selection procedure of the menu. ) " : . . Large Numbers
e _ @ : Marks additional information you may find of RAW Images
Square brackets are used to indicate items such helpful. —
as menu names, button names and window . .
names that appear on the computer screen. Switching Between Pages s'}\%’gfi:‘eg
Text inside < > indicates a key on the keyboard. Click on arrows on the bottom right of the screen.
p.** indicates a reference page. - next page -
Click to move to the relevant page. .p J Spedifying
o ) €D : previous page @
indicates the function for advanced
users who are experienced in handling image @ : return to a page you had previously
processing software. displayed Relfgazr;(ce/
"2 : Marks helpful information when a problem Click on the chapter headings on the right side

of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

© CANON INC. 2016 CEL-SW9NA210

Q0O

ENGLISH




Introduction

Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

* indicates processing that can be performed with JPEG or
TIFF images as well as RAW images.

View and organize images

Adjust an image
Various image adjustments while maintaining the original image

Freely apply a Picture Style

View your image before and after adjustment in the same window

Trim and adjust the angle of an image

(trimming)

Resize an image
Correction of lens aberration

Digital Lens Optimizer
Automatic/manual dust erasure processing

JPEG/TIFF

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print an image
Link with EOS Utility for remote shooting

Color management compatibility
CMYK simulation for commercial printing
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Introduction

System Requirements Supported Images Contents
gﬂgﬁ“;’at'“g Mac OS X 10.9 to 10.11 Image data =
. - Image type Extension Downloading
Model PC with one of the above OS preinstalled , Images
(Upgraded machines not supported) _RAW | Images in the Canon RAW format shot | ~p,
Core 2 Duo 2.0 GHz or higher (recommended Core i Still |images | on supported cameras
CPU series or later) photos | JPEG | Exif 2.2, 2.21 or 2.3-compatible JPEG | |5 Viewing
images | images ' Images
RAM 2.0 GB or more of RAM (4.0 GB or more
(memory) recommended) Movies Movies shot with supported cameras mg‘\{ i
Hard disk Installation: Min. 300 MB of available space : frg;tégg
drive Operation: Min. 600 MB of available space
Resolution: XGA (1024 x 768) or more (1600 x 1200
Display or more recommended) Editing
Colors: 16-bit color (65536 colors) or more Images
S ———
Supported Cameras prrting
ma
EOS-1D X Mark 1I, EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds ges
Mark Ill, EOS-1D Mark Ill, EOS 5DS/EOS 5DS R, EOS 5D Mark IV, Processing
EOS 5D Mark Ill, EOS 5D Mark II, EOS 6D, EOS 7D Mark Il, EOS 7D, Large Numbers
EOS 80D, EOS 70D, EOS 60D/EOS 60Da, EOS 50D, EOS 760D, of RAW Images
EOS 750D, EOS 700D, EOS 100D, EOS 1300D, EOS 1200D, EOS C—r
650D, EOS 600D, EOS 550D, EOS 500D, EOS 450D, EOS 1000D, Remote
EOS 1100D, EOS M5, EOS M3, EOS M2, EOS M, EOS M10, Shooting
PowerShot G3 X*, PowerShot G1 X Mark II*, PowerShot G7 X*, —
PowerShot G9 X*, PowerShot SX60 HS*, PowerShot G5 X*, PowerShot -
G7 X Mark II*, PowerShot G16*, PowerShot $120%, and PowerShot G1 X* popecifying
* For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if not in Reference/
the camera, can be used with the exception of some functionality. Index
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Displaying the Main Window (Multi-layout)............ 17
Checking an Image Using the Preview Control
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Checking an Image in Multi-Function Preview....... 22
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Changing the Display Method and Order of
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Changing the Display Method (Dock/Float) of
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Moving Images in Folders ..........ccooovviiiiiiviiiineeees
Registering Frequent-Use Folders (Bookmark
Registration) ...
4 Editing IMages .........oviiiiiiiii e
RAW IMAQESs ..o
RAW IMages ....coovvviiiieiiieeeeeee e
RAW Development...........ccooiiiiiiiiiiiiieeeeeeee,
When RAW Development is to be Done ................
Advantages of a RAW Image ...........ccoovvvvvveeeenennn.
Editing JPEG and TIFF Images..........cccovvvvvvcceieeeennee.
Tool Palettes.......cooooviiiiii e,

Editing with the Basic Adjustment Tool
Palette ..o
Adjusting Brightness.........ccccooveviiiiiiiiiiiieeee

Changing the Picture Style.............cccooeeeiiiriiiinnnnnnn.
Using a Picture Style File..........................
Adjusting Color Tone by Changing White
BalanCe.......coooiiiiii e
Adjusting Color Tone Using Click White
BalanCe........ooooiiiii e
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X Adjusting White Balance with Color

Temperature .........ccccvvviiiieieee e 48
Tuning White Balance .............ccccc............ 48
Adjusting Contrast ..........cccvveeeeeiieiiiiiee 49
Adjusting Brightness of Shadows/
Highlights ......ovveeiiiee e 49
Changing Color Tone and Color Saturation........... 50
Adjusting Dynamic Range......................... 51
Adjusting Gradation and Luminance
Automatically ..........ooooiiii 52
Using the Auto Lighting Optimizer........................ 53
Adjusting Image Sharpness...........cccoooiiiiiiiineene.. o4
Editing with the Tone Adjustment Tool
Palette......oooeeeeeeeeee 56
Adjusting Brightness and Contrast ....................... 56
Adjusting Color Tone Using Click White
BalanCe.........oeveiiiieeiiiii e 57
Adjusting Tone Curve...........ccccccvvvveeeenn... 58
Adjusting Dynamic Range............cccccce...... 60
Using the Auto Lighting Optimizer........................ 60
Editing with the Color Adjustment Tool
Palette......oooeeeeeeeeee 61
Editing with the Color Adjustment Tool
Palette.. ... 61
Editing with the Detailed Adjustment Tool
Palette. ..o 63
Reducing NOISE ..o 63
Adjusting Image Sharpness............ccoooeeciiiieenn.n. 64
Editing with the Trimming/Angle Adjustment
Tool Palette...........cccoooeiiiee, 65

Editing with the Lens Correction Tool Palette............. 68
Correcting Lens Aberration.............ccoocccvvviveeeeeen.n. 68
Making Corrections............ccoooveiiiiiiiiieiiiieeeee e 69
Shooting Distance Information Slider ..................... 71
Correcting Multiple Images ata Time..................... 72
Digital Lens Optimizer .............ccoccoiiveeieieeeeeeee, 72
Using the Digital Lens Optimizer............ccc.ccooooeo. 73
Adjusting Image Sharpness............cccccevvvviviineeeneee. 75

Editing with the Dust Delete/Copy Stamp

Tool Palette .......evveeeeeieee e 76

Performing Automatic Dust Erasure Processing .... 76
Automatic Dust Erasure Processing in the Main

WINAOW ...t 77
Manually Erasing Dust (Repair Function)............... 78
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLion).......oeee e 80
Setting Work Color Space...........oooccciiviieeeiieeeeeeeeens 81
Using the Soft-Proof Colors Function........................ 82
Saving Editing Results.................cccuuu. 83
Saving Editing Contents to an Image ..................... 83
Saving as a separate image .............cccccciiiieeeeeeennn. 83
Re-Editing an Image.......................ee 85
Utilizing Adjustment Contents (Recipe)..... 86
Copying a Recipe and Applying to Another
IMAgE. .. e 87
Savinga Recipeas aFile.....cccccccoiiiiiii. 87
Loading and Applying Recipes...........cccccevvvvveeeeen. 88
(pecmiFr) Adjusting by Comparing Multiple
IMAGES ... 89
Editing Efficiently ... 90
Editing in the Edit Image Window..............cccceeen. 90
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Changing the Thumbnail Display Position to

Horizontal...........cooiiiiiiiiieecee 91
Gathering and Editing Images in the Collection
WINOW ... 92
Compositing Images.............cceecvvvvveeeenn... 94
Compositing Methods ... 97
Creating HDR (High Dynamic Range)
IMAGES .. 98
Using the Dual Pixel RAW Optimizer......... 101

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel

RAW File.....ovveieiieeeeee e 101
Reposition the Viewpoint or Foreground Bokeh
for a More Pleasing Result ..............cccccvvvineeee.... 102
Reduces the Appearance of Ghosting in
IMAGES ... 103
Transferring a RAW Image to
PhotOSOP....coviiiii e 105
Customizing the Main Window Toolbar...... 106
5 Printing ImMages........coooiiiiiiiiiii e 107
Printing an Image.........ccccc e 108
Printing with Shooting Information........................... 109
Printing a Thumbnail List (Contact Sheet
PrNtiNg) ...eeeeeeeeeee e 110
Plug-in printing.........ccoooiiiiiiiieeeee e 111
6 Processing Large Numbers of RAW Images...... 112
Batch Apply White Balance to Images (Personal
White BalancCe) .........ccevveeeeiiiiiiiiiiiiiieeeeee e, 113
Registering Personal White Balance ................... 113
Applying Personal White Balance........................ 114

Batch Save as JPEG or TIFF Images (Batch

ProCEeSSING).....uueuiiiiiieree e

Batch Transfer Images to Image Editing

SOftWare ..o

Batch Change the File Name of Images...................
Changing the File Name of Images in the Order

in the Main Window ...........ccooiiiiiiiiiiiiicie e

7 Remote Shooting ........ccooovvvvviiiiiiiiiicee e,
Remote Shooting.......cccooeeiii
Registering Click White Balance in the Camera...

8 Specifying Preferences..........ccccoovvvviiieiiiinnnnn.n.
Specifying Preferences...........cccccviiiiiiiiiiiiiiiiiinnnnee,
General Settings..........cooovviiiiiiiiiee
Image ProcesSiNg .......cooeeevveeiiiiiiiieeeeeeeeeie e
Color Management..........c.ocooevviiiiiiiiiee e,
View Settings......ooovvviiiiei e

Reference ...
Troubleshooting..........ccouuiiiiiiii
Deleting the Software (Uninstalling) .........................
Image Frame Information in the Main Window and
Edit Image WiNndow...........cooooiiiiiiiiiiie e

123

* Sections with and in “4 Editing Images”

support not only RAW image editing but also JPEG/TIFF image
editing.
: All the functions explained in the section support

JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.
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1 Downloading Images

Introduction
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Starting UPp DPP ... 8

Downloading Images to Your Computer.................... 9
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Starting up DPP

Double-click the Dock icon.

Double-click

DPP starts up and the main window (thumbnail layout) appears.

v

@ If you drop a DPP-supported image file onto the icon on the Dock,
you can start up DPP and display the folder where the image file is
saved.
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Downloading Images to Your Computer

Download the images saved on the memory card inserted in the

camera.

Downloading Images Using the Software “EOS Utility”

You can download images with “EOS Utility”, communication software

for the camera.

For detailed instructions on downloading images, refer to the “EOS
Utility Instruction Manual” (PDF electronic manual).

Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.
Start up DPP beforehand.

Open a removable disk icon in the folder area and
drag the [DCIM] folder to the [Desktop].

(_#& Digital Photo F ional 4 File Edit View Thumbnails _Preview |
600

Remote Shooting

Folder Bookmark

A o5 DIGITAL
= pcim
| misc

B Macintosh HD
8 Applications
3 Library

8 system
i Temporary Items
Users

8 shared

£ o

The [DCIM] folder is copied to your computer.

All images are saved in folder units inside the [DCIM] folder.
Copying images to your computer will take some time when there
is a large number of images saved on the memory card.
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D Viewing Images

|

Viewing Images in the Main Window (Thumbnail Layout) ........... 11
Changing the Thumbnail Display............ccccccvvvvvvvnnnnes 11
Using the Thumbnails Control Panel ........ 12
Using the Thumbnail Display Filter/Sort
FUNCLON ..., 13
Displaying the Histogram Palette.............. 14
Enlarging and Viewing an Image in the Preview Window ............ 15
Enlarging and Viewing a Specific Area....................... 15
Displaying the Navigator Palette................ 16
Checking the Image in Detail ...................... 17
Displaying the Main Window (Multi-layout)................. 17
Checking an Image Using the Preview Control Panel......... 18
Changing the Magnification ..............cccccccvvveeeeenn.... 18
Comparing with a Pinned (Fixed) Image ................ 18
Displaying Multiple Images at the Same Time ....... 19
Displaying Grid Lines............coooiiiiiiiiiiiiiieeeee s 19
Displaying AF Points ..........cccoociiiiiiiiieeee e, 19
Displaying Areas Beyond the Set Range with Warning
Indicators (Highlight/Shadow Warning) .................. 20
Comparing Pre- and Post-Editing Images (Single-
Image Display)......cceeeeeeiiiiiiiiiieeeeeeee e 20

Comparing Pre- and Post-Editing Images (before/after
comparison) Arrange vertically/horizontally (two-
screen display) / Split vertically/horizontally (split-

image disSplay) ....ccccueeeeeiiieeieee e 21
Displaying Image Properties...........ccccceveeeeeeeiinennnn. 21
Checking an Image in Multi-Function Preview ........... 22
Checking an Image in Second Windows.................... 23

Opening and Closing Window Panels (Panes)........ 24
Changing the Display Method and Order of Palettes ....... 25
Changing the Display Method (Dock/Float) of Palettes....... 25
Rearranging Palettes.............cccooiiiiiiiii 25

QUIttING DPP ... 26
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Viewing Images in the Main Window (Thumbnail Layout)

Images downloaded to your computer are displayed as a thumbnails list
in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.15) and display the image at large size.

Main window Toolbar

KKKKKK

Check marks (p.30, p.31) Forward/Reverse
Ratings (p.30, p.31) Rotate image

For information on icons displayed on the frame of a thumbnail, see “Image
Frame Information in the Main Window and Edit Image Window” (p.134).

@ If you double-click on the movie file, the movie playback application
specified with the computer’s OS settings will start up and play back
the movie. In this case, edited movies will not be played back. You
can also change the movie playback application to EOS MOVIE
Utility with Preferences (p.126). For detailed instructions on EOS
MOVIE Utility, refer to the EOS MOVIE Utility Instruction Manual.
When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark Il, the image is
displayed as a cropped image (p.65).

In the main window, in addition to this view (thumbnail layout), you
can select multi-layout. Multi-layout allows you to check the image in
detail (p.17).

Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu » desired item.

Thumbnais

Open preview screen #0

+ Thumbnail control panel “C#N

Apply display filter
Sort >
+ Group RAW and JPG versions

Hide file name
+ Default

With shooting info

Size 1 (B4x84) #®1
Size 2 (126x126) ®2
+ Size 3 (168x168) #3
Size 4 (252x252) ¥#4
Size 5 (384x384) #5
Size 6 (512x512) #6
AF points AY|

The display changes to the selected item.
To display thumbnails with shooting information attached, select
the [Tools] menu » [Settings for thumbnails with shooting info].
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Using the Thumbnails Control Panel

The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions

(1)
(2)
(©)
(4)
®)
(6)

3) 4(G) 6 ) ©)

y RAW HNE

LPECIN ]

Olte = lCl Change the size of thumbnails
uDispIay thumbnails without file names
EDispIay standard thumbnails

- Display thumbnails with information

Select information to display for thumbnails

Display a RAW image and JPEG image as a single image
Display a RAW image and JPEG image that were shot together
as a single image. When this setting is specified, viewing and
editing of images are as follows.

Image displayed: Only the RAW image is displayed in all
windows.

Edited image: The content which has been edited with any of
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following
functions, the adjustments will be applied to both the RAW
image and the JPEG image.

* Deleting an image (p.36)

* Moving or copying an image (p.36)

» Checkmarking (p.30 to p.31)

* Rating (p.30 to p.31)

* Rotating an image (p.11)

(7) ESeIect all thumbnails
(8)

Cancel all thumbnail selections

The thumbnails control panel is displayed in the main window by
default. If it is not displayed, such as when screen settings have
been changed, you can display it by selecting [Thumbnail control
panel] in the [Thumbnails] menu.

In multi-layout (vertical thumbnails, p.17), only the thumbnail view
settings (Default thumbnail display/Show thumbnails without file
names) are possible.
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Using the Thumbnail Display Filter/Sort

Function

This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

Click the [ )] button at the bottom of the main

window.

Filter Off

Specify settings.

T B EE
The [Filter/Sort] palette is displayed.

Filter/Sort
Filter Off
B Apply to all folders

Check mark

1 G2 3 T4 TS5 O None

Clear all

Rating

« B Eearthe =]
Select All | |

Extension
G CR2 & CRW & MOV
& JPG & TIFF

Clear all

File name * G

Ascending

(1) Thumbnail display filter on/off
By setting to [On], only thumbnails matching the filtering option set
with (2) the filtering options menu are displayed.

(2) Filtering options menu
Select a filtering option for the thumbnail display filter.

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a
temporarily displayed after the option name.

ke

is

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.

Click the [] button again to hide the [Filter/Sort] palette.

When [Apply to all folders] is checkmarked with the thumbnail display
filter/sort function, filter settings will be kept and applied when you
switch to a different folder or the next time DPP is started up. When it
is not checkmarked, filter settings automatically change to [Off] when
you switch to a different folder or the next time DPP is started up.

 E———

Introduction

M —

Contents

N —

Downloading
Images

Sorting
Images

N ———

Editing
Images
Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

|

Specifying
Preferences

|

Reference/
Index




Displaying the Histogram Palette

The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu » [Histogram palette].
The histogram palette appears.

Histogram

You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]

You can click the [] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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Dbl Adusine

[}

The preview window appears.

Up to 36 windows can be displayed at the same time for the

preview window.

Double-click

Preview window '

T T T W

preview window.

A

Tool palette

@ By selecting the [Preview] menu » [AF points] in the preview

window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for

images whose image size has been changed and then been

converted and saved (p.83), images for which you selected an

effect other than [Shot settings] as correction of fisheye lens

distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or

chromatic aberration correction.

Enlarging and Viewing an Image in the Preview Window

Enlarging and Viewing a Specific Area

Click the area you want to enlarge.

o e e e SR

The area you clicked is enlarged to 100% (actual pixel size).
Click again to revert to the full view.
To change the display area drag on the image.

-Z@/E To display an image in an enlargement ratio other than 100%

Select any enlargement ratio from the [Preview] menu.

@ While in the preview window, you can select the [Preview] menu »
[Preview control panel] to use various preview functions. For details,
see “Checking an Image Using the Preview Control Panel” (p.18).
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Displaying the Navigator Palette

The navigator palette shows the enlargement area of a selected image.

Select the [View] menu » [Navigator palette].

The navigator palette appears.

Navigator

IMG_0001.CR2
EOS XXX
Tw 1740
T S Av5.6
"F.I.I e rvﬁ s
o i e 150 3200
34.0mm

When an image is enlarged in the preview or other window, the
enlargement display area is indicated in the navigator palette.
The area to be enlarged can be changed by dragging the
enlargement display area on the image.

Navigator

IMG_0001.CR2

IS0 3200
34.0mm

— Change the
enlargement display
area by dragging

You can click the [[E]] button at the bottom right of the main
window to show/hide the [Navigator] palette.
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Checking the Image in Detail

Displaying the Main Window (Multi-layout)

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).

The main window (multi-layout) appears.

In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.
Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the

image again to revert to full display.

Main Window (th

Multi-layout

Layout change button

Horizontal thumbnails

Vertical thumbnails

Preview
display area

Thumbnail
display area
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Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail.

You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [[#]] button and [] button are selected.

Changing the Magnification

200% v @ @ v = - |E| B v

Display the image at actual pixel size (100%).

Click the [[§ ] button to display the image at the set
magnification displayed. If the [[EJIE]] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.

*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.

Select an image and click the [[i]] button.

600 Dig Macintoth HD/Users o Deskiop oo 03]

Pinned (fixed) image

The window divides into left and right, and the selected image is
pinned.

When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.

After pinning an image, you can click the [[ig]] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time Displaying AF Points

Contents

x1 200% v @ @ [M~[A~[g~ & &~ x1 200+ © @ [F~[[A~[2~5 B8~ &~ OF~- H-~

Select multiple images, and click the [[&]] button.

The selected image is displayed.
You can display up to 8 images.

Displaying Grid Lines

window. Sorting
. ~ =~ T . ] . Images
x1 200% v ©@ ® [FA~[[A-[E- M &~ & Select an image and click the [[E]] button.

. . An image with the AF points selected in step 1 is displayed. v
Click the [[§] button beside the [[]] button, and set E:";té';g
the spacing between grid lines on the menu that
appears. —

Printing

To set the spacing, enter values (8 to 256, in pixels), or move the Images

slider.

After specifying settings, click the [Close] button and close the Processing

window Large Numbers

. of RAW Images
Select an image and click the [[]]] button. -
emote

The image with grid lines is displayed. Shooting

Specifying
Preferences
Reference/
Index

Click the [[§] button beside the [[E]] button, and
select the item to display on the image on the menu
that appears.

Select [Show only AF points in focus] or [Show all AF points].
After specifying settings, click the [Close] button and close the

@ AF points are not displayed for images whose image size has been

changed and then been converted and saved (p.83), images for
which you selected an effect other than [Shot settings] as correction
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for
distortion correction or chromatic aberration correction.
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Displaying Areas Beyond the Set Range with
Warning Indicators (Highlight/Shadow
Warning)

You can set up warning indicators for both highlighted and shadowed
parts, which is effective for checking the clipped highlights and shadows
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted
part in red and the shadowed part in blue.

200 v O @ v v - IE B or &

Click the [[]]1 button beside the [EF]]] button, and
specify settings on the menu that appears.

800 Highlight/shadow warning display settings

(¥ Show shadow warni ngs
Threshold:(0-64) 32

Warning color Iil

[EI Show highlight warnings
Threshold:(192-255) 754

Warning color Iil

| Close |

Checkmark the [Show highlight warnings] and [Show shadow
warnings] checkboxes and enter the warning values.

You can also select different warning colors from the dialog that
appears when you click the [Warning color] box.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[[F]] button.

On the opened image, if there is an area that exceeds the value
entered in step 1, the highlighted part of that area is displayed in
red and the shadowed part is displayed in blue. If you selected
different warning colors, the parts are displayed in the specified
colors.

Comparing Pre- and Post-Editing Images
(Single-Image Display)

x1 200%+ @ @ -/ OB - 9% H-~

Select an image that is being edited and click the
[[iE] button.

By clicking the button, the display switches between the image
before editing and the current image (being edited).
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Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)
You can display before and after versions of an adjusted image in the
same window and check the adjustment results.

This function allows you to adjust an image while comparing the original
image and image being edited.

200~ @ @ [T [f-[-0e =@ - %- H-

Select an image that is being edited and click the
[[Ed] button.

(o3

Sralh Preiew bl A T 73 5w i G =)
00 ottt o s O e e Dk

i il | B e e | R i 2 2

The image is displayed in two-screen display (Arrange vertically).

The image before editing is on the left, and the currently edited is
on the right.

Change the image display.

The display switches in the following order by clicking the [[il]
button.

Arrange vertically (two-screen: left/right) = Arrange horizontally
(two-screen: top/bottom) — Split vertically (split-image: left/right)
- Split horizontally (split-image: top/bottom)

Displaying Image Properties
Display the shooting and recipe information for an image in the screen.
You can select items to be displayed.

200% v =B @ v v v IEl BEor & v O~ H -

Click the [[]] button beside the [[[Z]] button.
The [Preview properties display settings] window appears.

Specify display settings.

-NaNa Preview Properties Display Settings
() Show recipe details
(*) Show shooting info
e EVRS T Shooting info display settings |
™ Brightness adjustment ™ Color adjustment
E]White balance @ Lens correction
@Picture Style || Dual Pixel RAW Optimizer
E] Sharpness l?] Cropping and rotation
E]Auro Lighting Optimizer l?] Rotate left / Rotate right
12] RCB tone curves l?] Stamp
12] MNoise reduction EI Color space
Clear all || Select all
Close

To display recipe contents, select [Show recipe details] and
checkmark items you want to display in the [Recipe display
settings] tab sheet.

To display shooting information, select [Show shooting info] and
checkmark items you want to display in the [Shooting info display
settings] tab sheet.

After specifying settings, click the [Close] button.
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Select an image and click the [[[i]] button.

The image and properties selected in step 2 are displayed in the
screen.

If the recipe contents of an image being edited are displayed in
before/after comparison (two-screen display/split-image display),
edited items are displayed in red.

@ All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.

Checking an Image in Multi-Function Preview

The preview window shows the coordinates of the mouse cursor and the
work color space. By switching to multi-function preview, you can also
check image details in the same way as the main window (multi-layout).

Select the [Tools] menu » [Preview screen display
settings], and then [Multi-function preview] from the
dialog that appears.

After selecting, click the [Close] button.

Open the preview window (p.15).

A multi-function preview with various functions at the bottom of
the screen is displayed.

800 Digital Photo Professional 4 - [IMG_0001.CR2]

For how to use the displayed functions, see “Viewing an Image in
the Main Window (Thumbnail Layout)” (p.11) and “Checking an
Image Using the Preview Control Panel” (p.18 to p.22).
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Checking an Image in Second Windows

Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,

R
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Downloading
Images

Select an image, and then select [Show second
screen] from the menu that appears when you right-
click with the mouse.

facar Fie €61 View Trumbrais Preaew _Libel_Aguit

A . 1

il | @ W 1oe

A second window is displayed.

To display an additional second window, repeat the operation.
You can change the size of second windows as desired.
Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.

When you magnify an image in the second window, the right-
clicked position on the image will be the center for the

magnification.
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Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [[J"l]] for a panel to open or close.

Example: main window (thumbnail layout)

When a panel is closed, you can point to [[JJl]] with the mouse
to temporarily open the panel.
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Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
A docked palette is then displayed floating, and a floating palette
is then displayed docked.
To revert to the original display method, repeat the same
operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.

The order of the palettes is changed.
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Quitting DPP

In the main window, select the [Digital Photo
Professional 4] menu » [Quit Digital Photo
Professional 4].

Digital Photo Professional 4

About Digital Photo Professional 4
Preferences... %,
Service >

Hide Digital Photo Professional 4  &H
Hide Others E#H

Show A

[ Quit Digital Photo Professional 4 S%Q]

DPP quits.

@ A confirmation dialog box for saving the images appears when you
try to quit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images
adjusted.

R
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3 Organizing and Sorting Images

Efficiently Checking/Sorting Images.............ccccc....... 28
Sorting IMages ........uvveeeeeeiiieiiiee e, 30
Attaching Check Marks............ccceeeeeeeeeieieeiicnnneee, 30
Setting Ratings ........ccccoiiiiii 30
Sorting Images in the Main Window ..............cccccce..... 31
Attaching Check Marks in the Main Window .......... 31
Setting Ratings in the Main Window....................... 31
Arranging Images in the Main Window....................... 32
Arranging by TYPE ......oooiiiiiiiieieeeeee e 32
Arranging Freely ..o 33
Displaying a RAW Image and JPEG Image as a Single
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Checking Image Information............ccccociveiiiiinnenn. 34
Organizing IMages .......ccceeveeeeeeeeeeeeeeceee e 36
Deleting an Unwanted Image ..............cccccvvvvvveenennnnn. 36
MOVING IMAgES ......eveiiieiiiiiiiii e 36
Moving Images in Folders ..........cccccccoeoiiiiiiiinieennnn... 37
Registering Frequent-Use Folders (Bookmark
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.

Select multiple images to check in the main window.

Display the quick check window.
Click the [Quick check] button.

I" Digital Photo Professional 4 File Edit View Thumbnails Preview
8 00

Edit Image Quick Check Remote Shooting

Folder Bookmark V3

The quick check window appears.

Click the [[E] or [[] button to switch between
images to be checked.
Quick check windo

Introduction

M —

Contents

[ Digital Phota Professional 4 _File Vi b nail i Label_Adjustment_Tc
800

All the images displayed in the main window can be checked in
the quick check window.

If you click the [[Bl] button, the first image is displayed, and if you
click the [[g]] button, the last image is displayed.

Click the [[B]] button to return to the main window.
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Click the area you want to enlarge.

T T T T
Do

AT )

v ’ - - T

The area you clicked is displayed at 100% (actual pixel size).
To change the display position, drag on the image.

If you click the [ ] button, you can display the image at 50%.
Click again to revert to the full view.

To quit, click the [[E]] button.

In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [ﬂ] button beside the

] button on the screen, select a magnification from the menu
that appears, and click the [close] button.

If you click the [ ] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.83), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

Ay

-@> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switching between images using the keyboard

You can also switch between images by pressing the <3 >+ <—>or
<3 >+ <> keys.

Operations using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[El] to [E]-

Thumbnail position
© Bottom

@ L=ft

1/41 v"z -.2’3 J.ﬂ. 1/5

The selected check mark appears in the upper left of the window.

Ch(lack mark

Click

s _Provien _iabel _Adjusiment

[3
X

Click the [Clear] button to remove the check mark.

The values of check marks attached to images in versions before

DPP 4 are not maintained.

You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the

<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [¢].

Thumbnail position
© Bottom @ Left

bz s s P

Click

The rating is set and an icon corresponding to the selected [{%7]
appears in the upper left of the window.

(Window shown with a rating of three [%])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

To cancel the rating, click the same [¢%] as when the setting was
made on the right of the window.

@As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [5%] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [El] to [E]-

Select

Click

The selected check mark appears in the upper left of the image
frame.

Check mark

d T 1

=TT 1T

sRGB / sRCB

Click the check mark again to remove the check marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [¢].

J Tl 1

| = B W e
Select

sRGR [ sRCE

Click (changes to [§%] after clicking [ @])

The rating is set and an icon corresponding to the selected [¢%]
appears in the image frame.
(Sample window shown with a rating of three [¢%] as an example)

LTI

| B N e

Rating icon

To cancel the rating, click the same [$%] as when the setting was
made.
Set [Reject] with the [Label] menu or the quick check window

(p.28).
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A
~

:@/E To select multiple images in the main window

Click on desired images while holding down the < 38 > key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

@ The [Label] menu can also be used to attach check marks and set
ratings.

You can display and change the rating settings set in DPP with

other EOS software and with any supported EOS camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D Mark

IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 5D Mark Il, EOS 50D,

EOS 550D, EOS 500D, EOS 450D, and EOS 1000D.

« EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

» With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark IV, EOS-1Ds Mark |ll,
EOS-1D Mark 1ll, EOS 5D Mark Il, EOS 50D, EOS 550D, EOS
500D, EOS 450D, and EOS 1000D:

Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change in DPP the rating

settings set for images on any supported EOS camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D

Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 5D Mark I,

EOS 50D, EOS 550D, EOS 500D, EOS 450D, and EOS 1000D.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [Thumbnails] menu » [Sort] » desired item.

The images are arranged in the order according to the selected

item.

Sort item Description
File name: ascending Images are sorted by file name in alphanumeric
order order (0to 9 » Ato 2).
Extension: ascending Images are sorted in the following order: RAW
order images - JPEG images - TIFF images —

MOV movies = MP4 movies.

Shooting Date/Time:
ascending order

Images are sorted by shooting date and time
from the earliest.

Check mark:
ascending order

Rating: ascending
order

Images with check marks take priority and are
sorted in number order.

Sorted in order of fewest [$%¢].

Camera model Name: Sorted in order of least digit used in the camera
ascending order model name. (Ex.: EOS-1D X - EOS 6D)

Lens: ascending order Sorted in order of shooting lens with shortest
focal length.

ISO speed: ascending Sorted in order of lowest speed.
order

Shutter speed:
ascending order

Aperture value:
ascending order

Sorted in order of fastest shutter speed.

Sorted in order of lowest aperture value.

Focal length:
ascending order

Sorted in order of shooting lens with shortest
set focal length.

* Descending order sorts all items in the reverse of ascending order.
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Arranging Freely

Drag and drop the image to the desired location.

(®Diaal Photo Profession: Ei_ View Thumbrall Freview Label
500

T 5 = % Wen7sieW G = )

= a 4
P | et
oL 1110 :
T LTS ."
@

@

- 2 . » -

W - -"‘_'

I

The image moves to the desired location.

You can also select multiple images (p.32) and move them.

The order of rearranged images is temporarily registered as
[Custom] in [Sort] of thumbnails control area and maintained until
you exit DPP or select another folder in the folder area.

Select the [Thumbnails] menu » [Sort] » [File name] and [Ascending]
to revert to the order before the images were rearranged.

-:\@/E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you quit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View Settings] tab sheet in [Preferences] to maintain
the order of images without changing the image file names (p.130).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.118).

Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu » [Group RAW and

JPG versions].
The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(R+J)] mark (p.134).

'? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-:@/3 When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.36)

* Moving or copying an image (p.36)

» Checkmarking (p.30, p.31)

* Rating (p.30, p.31)

* Rotating an image (p.11)
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Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[R+D] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

@ If you cancel selection of [Group RAW and JPG versions], the RAW

image and JPEG image are displayed as separate images.

Checking Image Information

Select the image for which you want to check the
image information.

Select the [View] menu » [Info].
The image information window appears.

Select a tab sheet and check information.

Image information window

[Exif Information] [XMP/IPTC Information] [Recipes]
tab sheet tab sheet tab sheet

[®00 IMG_0001.CR2 MG_DD01.CRZ
XMP/IPTC Information | Recipes | | Exif Information Exif Information | XMP/IFTC Information
Item Value | Description ) Item value
File Name IMG_0001.CR2 {Document Titie] Brightness adju... 0.00
File Size 24.5MB 000000 White balance  (Auto)
Camera Model ~ Canon EOS XXX {Author] Picture Style (Landscape)
Firmware Firmware Version X.X.X XXO0O00HK Contrast 0.0
Shooting Date/...  XX/XX/XX XX:XX:XX [Author Title] Shadow 0.0
Owner's Name 0000000 Highlight 0.0
Shooting Mode  Aperture-Priority AE [Description] Color tone 0.0
Tu(Shutter Speed) 1/40 300000000 Color saturation 0.0
AviAperture Value) 5.6 [Description Writer] Linear off
Metering Mode  Evaluative Metering JOOO00U0K Black point 0.00
Exposure Comp... 0 [Keywords) Midpeint 0.00
150 Speed 3200 000000000 White point 0.00
Auto 150 Speed ~ ON [Copyright Status] Sharpress Strength : 4.0 Fineness - 4.0 Thr
Lens EF17-40mm £/4L USM X000 Auto Lighting O.... Standard
Focal Length 34.0mm [Copyright Notice] RGB tone curves  Original
Image Size HRXKK KK HOXKHNKKKK Reduce luminan._. 9.0
Aspect ratio 32 [Copyright infa URL] Reduce chromi 11.0
Image Quality RAW HOOXHDD0K Coler adjustment  Off
Flash off Hue 0.0
FE lock OFF Saturation 100.0
White Balance...  Auto Red off
AF Mode Manual focusing Orange off
Picture Style Landscape Yellow off
Green off
Aqua off
Blue off
Purple off
Magenta off
Lens correction  On
Digital Lens Opt... Off
Peripheral illum... 40.0
Chromatic aber... 100.0 R0.0 B0.0
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Shooting information is displayed in the [Exif Information] tab
sheet, while IPTC* information appended to the image after
shooting is displayed in the [XMP/IPTC Information] tab sheet.
IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [XMP/
IPTC Information] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Exif Information] tab sheet will vary
depending on the camera model.

Recipe contents applied to an image are displayed in the
[Recipes] tab sheet.

A/
~ -

-Q= Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the thumbnail with shooting information
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnails] menu » [With shooting info] (p.11).
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Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Move to Trash].

Close window W
Save 38S
Save As... 385
Convert and save... ®D
Batch process... 3B
Print... #P
Print with detailed setting... 3P
Plug-in printing >
1 ®G
llect %G
Select collection »
Delete collection [ 2
Bookmark
Remove bookmark
[ Move to Trash 3£<ZJ]

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Option> key
and release when the image is in the destination
folder.

Edit Image Quick Check Remote Shooting

Folder Bookmark

B Macintosh HD
#8 Applications
5 Library
- System
| ] Temporary ltems
B Users
8 Shared
A o
(] Desktop
8 Travel
8 Documents |
B Downloads ‘+ (MG_0001.CR2
8 Movies
B Music
B8 pictures
M Holiday
9 Public

¥

The images are moved or copied to the destination folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Option> key
and release when the folder is in the destination folder.

Edit Image Quick Check Remote Shooting

Folder Bookmark
B Macintosh HD
7y Applications ‘
0 Library
# System | g~ -
8 Temporary Items \i nl.f-. m il
8 Users
8 Shared
£ user
f# Desktop
& Travel
i@ Documents
8 Downloads
8 Movies
8 Music
B Picturac
™ Holiday
= Public

S5 | B B e

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

Select the folder for which a bookmark is to be
registered.

Edit Image Quick Check Remote Shooting

Folder Bookmark
B Macintosh HD
B8 Applications ‘
0 Library
e System | "
8 Temporary Items \i nl.i‘ h i
B9 Users
8 Shared |
£ user
fmt Desktop
= Travel
@ Documents
1 Downloads
8 Movies
8 Music
0 Pirturec
™ Foliday — Select
2 Public ;

Select the [File] menu » [Bookmark].
The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu » [Remove bookmark].
The selected folder is deleted from bookmarks.
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4 Editing Images

RAW IMages ....c.uiiiieiieeeee e
RAW IMages......coooiiiiiiiiii e
RAW Development ..........cccoooviiiiiiiiiiiiiiieeeeeeeen
When RAW Development is to be Done....................
Advantages of a RAW Image .............cevvvvvieiiiiinnnnnnnes

Editing JPEG and TIFF Images ............ccceevveeeennnnee
Tool Palettes ...

Editing with the Basic Adjustment Tool

Palette ...,
Adjusting Brightness ...,
Changing the Picture Style ...........cccoooeiiiiiiiieeenn,

Using a Picture Style File ...........ccccooveevenn...
Adjusting Color Tone by Changing White Balance....
Adjusting Color Tone Using Click White Balance......
XD Adjusting White Balance with Color

TempPerature ..........coevee i
Tuning White Balance................cccceeevveenen.
Adjusting Contrast ...........ooeeviiiiiiiiiiiiiiiiis

Adjusting Brightness of Shadows/

HIghlights ...

Changing Color Tone and Color Saturation...............
Adjusting Monochrome............cooieiiiiiiiiieeiiiinn.

T Adjusting Dynamic Range...........cccoevee......
Adjusting Gradation and Luminance Automatically ...
Using the Auto Lighting Optimizer............................
Adjusting Image Sharpness.........ccccccceeeviieiiiiiininnnnnn..

Detailed Setting of Image Sharpness ....................

43
43
44

46
46
47

48

48
49

49
50
50

51
52
53
54
55

Editing with the Tone Adjustment Tool

Palette ... 56
Adjusting Brightness and Contrast...................co.o... 56
Adjusting Color Tone Using Click White Balance....... 57
A Adjusting Tone CUrve .........occveeeceeeeeveeenee. 58

Example of a Tone Curve Operation...................... 59
A Adjusting Dynamic Range...........cccocccveenne.. 60
Using the Auto Lighting Optimizer...........cccccccooennee. 60

Editing with the Color Adjustment Tool

Palette ... 61
Editing with the Color Adjustment Tool
Palette ... 61

Adjusting a Specific Color Gamut........................... 61
Adjusting Hue and Saturation for an Entire

IMAGE.....ccc e 62
Adjusting in Monochrome ............ccccceeeiiiiiinee e 62

Editing with the Detailed Adjustment Tool

Palette ... 63
Reducing NOISE ..........cooeiiiiiiiiieeeeeeee e 63
Adjusting Image Sharpness.............cccceevevvirieeneeenennn. 64

Editing with the Trimming/Angle

Adjustment Tool Palette ..., 65

Editing with the Lens Correction Tool Palette.......... 68
Correcting Lens Aberration............cccceeeeeeeeee e, 68
Making Corrections..........ccveevieiiiiiiiee e 69

Effects of Distortion Correction for Fisheye
LENSES ... 70
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Shooting Distance Information Slider ........................ 71
Correcting Multiple Images ata Time............cccccoe...... 72
Digital Lens Optimizer.........ccccccccooeeieiiiiiiiiieeieeeeeee 72
Using the Digital Lens Optimizer .............ccccooeeeeee. 73
Adjusting Image Sharpness..........ccccvvvvvvvvneeinnninnnnnnnns 75
Editing with the Dust Delete/Copy Stamp
Tool Palette ........cooo i 76
Performing Automatic Dust Erasure Processing ....... 76
Automatic Dust Erasure Processing in the Main
WINAOW ... 144
Manually Erasing Dust (Repair Function).................. 78
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ... 80
Setting Work Color Space.......ccccccceeevvvveeeeeeiiiin. 81
Using the Soft-Proof Colors Function....................... 82
(eeemirr ) Saving Editing Results.........cccooooeeeen. 83
Saving Editing Contents to an Image ........................ 83
Saving as a separate image ........cccccceeeeveeeiniinnnnnnnnn. 83
Re-Editing an Image..............ccoeiiiiins 85

Utilizing Adjustment Contents (Recipe).... 86
Copying a Recipe and Applying to Another Image.... 87

Savinga Recipeas aFile......cccccooiiiiiiiiiiii. 87
Loading and Applying Recipes.........cccccooiveeeeneennnnn. 88
(eeemier ) Adjusting by Comparing Multiple
IMAQGES ... 89
Editing Efficiently ............cccoooiiiii 90

Editing in the Edit Image Window............cccccvveeeeenn... 90
Changing the Thumbnail Display Position to
Horizontal ........cccoooiiiiiiiiii 91
Gathering and Editing Images in the Collection
WINAOW ....eeiiiiiiiiiiee et 92
Compositing Images............ccceeevvvvvviveeeeenen. 94
Compositing Methods.............oooiiiiiiiiii, 97
Creating HDR (High Dynamic Range)
IMAGES ... 98
Using the Dual Pixel RAW Optimizer-........ 101

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel

RAW Fil€ ..o, 101
Reposition the Viewpoint or Foreground Bokeh for
a More Pleasing Result ..., 102

Reduces the Appearance of Ghosting in Images..... 103

T Transferring a RAW Image to
PhotoShOp ..oveiie 105

Customizing the Main Window Toolbar .... 106

* Sections with and in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image

editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.
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RAW Images
RAW Images

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“‘development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.86).

iy

" RAW image

Contents adjusted using the tool

palettes can be handled
—1| individually as a recipe file

(extension “.dr4”) (p.86, p.87).

7

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.87), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.88). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.

» Tone Adjustment tool palette

* Color Adjustment tool palette

* Detailed Adjustment tool palette

» Trimming/Angle Adjustment tool palette

* Dust Delete/Copy Stamp tool palette

* Settings tool palette
Because adjustments made with these tool palettes (the recipe) only
change the image processing conditions, the “original image data itself’
remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.

Image processing conditions information

R — Contents adjusted using the tool
palettes can be handled
=—1 individually as a recipe file
(extension “.dr4”) (p.86, p.87).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.87), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.88). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.

R
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Tool Palettes

With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only
change the image processing conditions, the “original image data itself’
remains unaffected. As there is no image deterioration that normally
accompanies editing, you can readjust your image any number of times.
The various functions of the tool palettes are explained in more detail
under the respective topics.

Trimming/
Angle
Lens Adjustment
Correctiontool — tool palette
palette ]
Basic J Dust Delete/
Adjustment Copy Stamp
tool palette tool palette
Detailed Settings tool
Adjustment palette
tool palette
Tone : Color
Adjustment | | M — e G 00 [ Adjustment
tool palette W Auto Lighting Optimizer T~ tool palette

Low Standard Stro ng
Picture Style [
0 (Standard) - Browse...
Gamma adjustment

Auto B Linear
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 20 4.0

- -1

Vel .
000 '} 0.00 |

&% Move midpoint to match

Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.43).

Tone Adjustment tool palette

Adjusts the tone curve and applies the Auto Lighting Optimizer (p.56).

Color Adjustment tool palette

Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.61).

Detailed Adjustment tool palette

Reduces noise and adjusts the image sharpness (p.63).
Trimming/Angle Adjustment tool palette

Crops an image and adjusts the image angle (p.65).

Lens Correction tool palette
Corrects lens aberration in the image (p.68) and applies the Digital
Lens Optimizer (p.73).

Dust Delete/Copy Stamp tool palette

Erases dust from an image and corrects image by copying sections
of the image (p.76).

Settings tool palette

Configures the work color space (p.81).

5@/5 Using the different tool palettes

We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.56), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.63) and lens aberration correction (p.69), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.63) and Lens Correction tool palette (p.68).
You can click the [] button at the bottom right of the main window
to show/hide [Tool palette].
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JPEG/TIFF

Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW
images. With this tool palette, you can adjust the image brightness, set
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.

Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness.

Select an image in the main window, etc.

Display the Basic Adjustment tool palette.

Shadow

Highlight

Color &«

Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Toal palerte

! L
E] I 71 & H

Reverts the image to
the original settings

Brightness adjustment [

White balance adjustyment |y Enter a numerical

value
O (Auto)

Drag the slider left or right

@ The adjustment range is —3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Changing the Picture Style

Picture Style

If the image looks different from what you visualized at the time of

shooting, you can get it closer to what you expected by changing the

Picture Style. Even if you have saved the image (p.83) with

[Monochrome] (p.50) selected, you can still change to another Picture ﬂ( )
Style at any point by simply selecting a Picture Style other than

[Monochromel].

Picture Style

8 (Standard) :

Gamma adjustment

Auto

-10.0 -8.0 -6.0 -4.0 -2.0 0.0

& Move midpeint to match

Reverts the image to

Description

The Picture Style set with the camera when the
image was shot.

When a mode in the Creative Zone is selected on the
camera, the Picture Style set is displayed in ().

When a mode in the Basic Zone is selected on the
camera, [Shot settings] is displayed in (), and image
characteristics that are according to the selected
shooting mode are applied.

The image looks vivid.
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the original settings Standard Generally, this setting is suitable for most images. Sorting
Select The color tone will be adjusted to suit the scene. Images
The colors will look vivid. Especially the colors of
Auto . . L
blue skies, greenery, and sunsets will be vivid in a Edifhg
shot of nature, outdoor, or sunset scenes. I#s
For nice skin tones.
. Effective for close-ups of women and children. By -
Portrait . . : Printing
changing the [Color tone], you can adjust the skin Images
tone (p.50).
For vivid blues and greens. Processing
Landscape Effective for making images of landscapes Large Numbers
impressive. of RAW Images
Suited for detailed outline and fine texture Remot
Fine Detail description of the subject. The colors will be slightly Sh%rggneg
vivid.
For natural colors and subdued images. -
. . . Specifying
Neutral Effective for base images which are to undergo BEAF. oo leee
adjustment.
When the subject is photographed under a color
temperature of 5200K, the color is adjusted Relfﬁa:‘(cel
Faithful colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment. @ @
For black and white images.
Monochrome  You can also adjust with [Filter effect] or [Toning

effect] (p.50).
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Picture Style

(Picture Style file
registered in the

camera)

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

[Picture Style file
applied in DPP]

The name of the Picture Style file applied in DPP is
displayed in[].

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.

[Auto] is not applied to images shot with the EOS-1D Mark 1V,
EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 5D Mark Il, EOS 7D,
EOS 60D/EOS 60Da, EOS 50D, EOS 550D, EOS 500D, EOS
450D, EOS 1000D, EOS 1100D, PowerShot G3 X, PowerShot
G1 X Mark I, PowerShot G7 X, PowerShot G9 X, PowerShot
SX60 HS, PowerShot G5 X, PowerShot G16, PowerShot S120,
or PowerShot G1 X. When changing the Picture Style with
several images selected, although you can select [Auto] if images
shot with any supported camera other than the above are
included, [Auto] will not be applied to the images shot with the
above cameras.

You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark I, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S120, and
PowerShot G1 X.

You cannot select [Auto] with multiple-exposure RAW images
created with the camera.
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Using a Picture Style File

A Picture Style file is a Picture Style extension file.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon website effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Click the [Browse] button in the [Picture Style] panel.

Picture Style | sy
0 (Standard) S

Gamma adjustment 82

Browse...

Auto B Linear
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0 4.0

[ N

The [Open] dialog box appears.

A

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Tool palerte

Brightness adjustment

_'

White balance adjustment

Reverts the image to
I the original settings

Select

3 ( ) is the white balance set on the camera when the image was shot.

 When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ().

* When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.47).

-Z@/E Tune with color tone

To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.50) for tuning towards your expectations.

You cannot register the adjustment results as personal white
balance (p.113) when you have selected [ ()] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Tool palette

Brightness adjustment

White balance adjustment

* Click

The coordinates of the cursor position and
the RGB values (8-bit conversion)

Reverts the
image to the
original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [[JEgl}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

Brightness adjustment |4

e 0.00 {1
White balance adjustment |

ped Rex_ﬂﬁci !
-® 5200 | Displays the value of
the setting

Drag the slider left or right

@ The adjustment range is 2000 to 10000K (in 10K increments).

Tuning White Balance

This is a function that makes fine adjustments to the white balance.
Using this function, you can achieve the same effects as third-party
color temperature conversion filters and color correction filters. The
adjustable range is £10 steps. This function is aimed particularly at high-
end users who are familiar with the roles and effects of color
temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

Fine-tune

Enter the values to set

Drag Drag the sliders left
or right

B stands for blue, A for amber, M for magenta and G for green.
The color is adjusted towards the color to which the point moves.
You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.

@ To register the adjustment outcomes as a personal white balance
(p.113), select a setting other than [ g% ( )] from the [White balance
adjustment] list box before tuning the white balance. If you
selected [ f4( )] from the list box and tuned the white balance, you
cannot then register the outcomes as a personal white balance.
You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

@ The adjustable range is 0 to £10 (in 0.1-stop increments when
entering a value).
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Introduction
S ——
Adjusting Contrast .
i i i i i ontents
Modulation and degree of contrast can be adjusted. Move the slider to AdeStlng Brlghtness of Shadowslnghllghts
the right to make contrast stronger and to the left to make contrast You can adjust the brightness of shadows and highlights in an image. T —
weaker. By adjusting only shadows or highlights in an image, you can reduce the Downloading
effects of clipping in shadows and highlights. Images

Picture Style Reverts the image to

the original settings Picture Style
"

Viewing
Images

Gamma adjustment

Auto B Linear

-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0

Gamma adjustment ¥
Auto @ Linear sortlng
Images
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0 d

Editing
| 3

—

i : ' ' '
0.00 |] s Printing
= = Images
& Move midpeint to match Drag the Slider |eft or m a
Advanced ¥ right (9 steps) & Move midpoint to match Processing
i i Advancec ¥ . Large Numbers
Contrast Enter a setting (in Advanced Drag the sliders left of R?AW Images
LEL LT 0-1'St0p mcrements) Contrast or rlght —
Highlight Shadow i i Remote
Color tone Highlight Enter a S.ettmg (In Shooting
Color sarurath 0.1-stop increments)
olor saturation Color tone EEEEEEEEEE—
Color saturation e B
- Specifying
Preferences
R —————
Reference/
Index
—_—

@ If you make a major adjustment to the highlights or shadows in an
image, the image may look unnatural. In such a case, reduce the @w
degree of adjustment.



Introduction
. . Adjusting Monochrome —
Changmg Color Tone and Color Saturation When the Picture Style (p.44) is set to [Monochrome], you can create Contents
Tone and overall color saturation can be adjusted. monochrome photographs with effects similar to filtering, or with a look
If Picture Style (p.44) is set to [Monochrome], [Color tone] and [Color of monotone color photograph. T —
saturation] switch to [Filter effect] and [Toning effect] (this page). Downloading
Select [Monochrome] in the [Picture Style] list box. Images

Picture Style 4= Reverts the image to

Browse. . the original settings , , Viewin
9 9 Picture Style [ Reverts the image to 9

Images

Gamma adjustment Browse... the original settings
Auto @ Linear Gamma adjustment ¥ Sortin
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 g
Auto @ Linear Images

500 1] T
£ Move midpoint to match m m a
Advanced & Move midpoint to match L PI'OCﬁSSiIl;g
Contrast Advanced 2 O?ngAeW 'ilrr:l‘a;:
Shadow . - Drag the sliders left or Contrast S—— ] e
Highlight right Shadow o XN O Slﬁemgte
i ootin
e Entr a sting (i oo Bl—— | S
0.1-stop increments) Flter effect == Displays the values of o
c . ] ) Toning effect _ the settings Spemfylng
olor tone: Move the slider to the right to make tones Preferences
more yellowish, and to the left to make tones e —
more reddish.
Color saturation: Adjusts the overall color intensity for the Relfﬁair)\(cel
image. Move the slider to the right for more

intense colors, and to the left for less intense

colors. @ @

@ The adjustment range is —4 to +4.



Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.

Filter Example of effect
None General monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepial], [Blue], [Purple]
and [Green].

ALy

=@ Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider to the right.

Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

0 (Standard)

Move downwards
Output white points

Move to the left or right
Input white points

Move to the left or right
Mid (medium tone) point

e —— — A Move upwards
o.o0 N o.oo M. ooo M Output black points

You can also adjust
the dynamic range by

ontila o entering values

ol 0.0
g g 0.0

olo 0.0

Move to the left or right
Input black points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input
black points.
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A/

=)< [Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.

@ [Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.53) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

Picture Style |
0 (Standard) :

Gamma adjustment

Browse...

Auto B Linear
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0

& Move midpoint to match

' '
' '
.

In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.

White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
Settings that are reset and those that are not with this adjustment
are as follows.

Settings that are reset

* Auto Lighting Optimizer

* [Contrast] in the [Advanced] panel

Settings that are not reset

- Brightness adjustment

- White balance adjustment

* Linear*

* White points and black points are automatically adjusted.

@ An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to
RAW images.

* ALO stands for Auto Lighting Optimizer.

Checkmark the [Auto Lighting Optimizer] checkbox.

Ei \wto Lighting Optimizer

Checkmark

Standard Stro ng

For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the setting according to your preferences.
i Auto Lighting Optimizer

Standard Select from three
levels: Low/Standard/
Strong

Auto correction is applied to the image to match the setting.

For the image shot with the camera’s Auto Lighting Optimizer function,
the setting at the time of shooting is applied as the default value.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

Low

@ When [Highlight tone priority] is set to [Enable] on any supported

EOS camera other than the EOS-1D Mark IV, EOS 5D Mark Il, or
EOS 550D, the Auto Lighting Optimizer cannot be used for RAW
images.

You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created with the camera.

When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].
[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The

further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

@ [Unsharp mask] cannot be used with images other than RAW
images.

Select [Sharpness] from the list box and adjust the
setting.

Picture Style (£ Y
0 (Standard) : Browse...

Gamma adjustment

Reverts the image to
the original settings

Auto B Linear

-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0

. 0. X
n "
= =

@ Move midpoint to match
Advanced ¥

Contrast . m s
Shadow — m
Highlight —_— m
Color tone . SR m e
—o— [N 6

Color saturation

& Sharpness
Strength s 1) — a

Select [Sharpness]
Enter a setting (in
0.1-stop increments)

Drag the slider left or right

@ The adjustment range is 0 to 10.
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Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and adjust

the setting.

Picture Style
0 (Standard) =
Gamma adjustment
Auto B Linear
-10.0 -8.0 -6.0 -4.0 =-2.0 0.0 2.0

:
). |

& Move midpoint to match

Advanced »

W
Contrast . L— m a
Shadow —_— m a
Highlight SR — m 8
Color tone B —— L— m a
Color saturation B —— L— m a
& Sharpness
Strength
Fineness

Threshold

Select [Unsharp mask]

Enter a setting (in
0.1-stop increments)

Drag the slider left
or right

@ Adjust image sharpness with the window view set to [400%], [200%]
or [100%)]. If the view is set to [Fit to window] (full view), you may not
be able to correctly check the adjustment results.

R
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JPEG/TIFF

Editing with the Tone Adjustment Tool Palette Introduction

With the Tone Adjustment tool palette, you can adjust images with the . . . ——r
same functions as general image editing software. Adjusting Brightness and Contrast c
ontents
. . . . The brightness and contrast of an image can be adjusted. Since the
Select an image in the main window, etc. adjustment range is broader than the same functions in the Basic D

Adjustment tool palette, the image color may be saturated, or the image Downloading
quality may deteriorate if you adjust too much. Be especially careful Images

Display the Tone Adjustment tool palette.

Tone curve adjustment
O RGERRGE @ Luminance RGB
© Curve @ Straight
RGB t #

GEGEETL M Edited image 4

Input level _a -~
Output level e - B

Brightness

Contrast

& Auto Lighting Optimizer

— ) —
Low Standard Strong

when adjusting.

=]

Tone curve adjustment
O RGERGEH @ luminance RGB
© Curve @ Straight
RGB : 2

—

1

| v CHENG
Output level ] ~ or rlght

Brightness

Contrast

Reverts the image to
the original settings

Viewing
Images

Drag the sliders left

Enter a setting (in
0.1-stop increments)
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Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

Contrast: Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

@ The adjustment range is —100 to +100 (in 0.1-stop increments when

entering a value).

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[lE@]] button.

] ) | 7 |
Tone curve adjustment
O RGERGBE ® Luminance R G B
0 Curve @ Strainhit
RGB

—

'|.

« CEENS

Input level

Output level
Brightness

Contrast

Introduction

M —

Contents

S

Downloading
Images

Viewing
Images

Sorting
Images

Editing
| s

—

Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

Specifying
Preferences

\

Reference/
Index




Click on a point that is to be the standard for white.

(& oigital i Fie Edil View Thumbnals Previen kabel Adjstment Teos Windon Hslp
000

v 4 MenZ5IPM Q= )

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [[JEgl]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.

Adjusting Tone Curve

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.135).

Select the tone curve mode and interpolation
method.

Tone curve adjustment
O RGERGBE ® Luminance R G B
0 Curve @ Strainhit

RGB

—

'|.

%

- T

Input level
Output level
Brightness

Contrast
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Make adjustments.

Tone curve adjustment

ORGBERGE @ Luminance R G 8

© Curve @ Straighit

[RGB ] RGB: Adjusts RGB
¢ in a batch

R, G, B: Adjusts

each channel

You can display pre-
and post-adjustment

histograms
X ' Coordinates of [[1]
Input level e - 8 (when several

Output level e - :] coordinates are set,
00 L coordinates of last-

Brightness L ]

Contrast [ ] m a set [ D ])

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[1] is 8.

To delete a [[], double-click on the [[]].

Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer

 E———
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards
Output white points

o
Tone curve ad]ustment | Reverts the
O RGBRGB Luminance R G 8 image to the
O Curve Straight original
RCB : settings
s Ghint Ml Ed ted image =
Move to the = — Move to the
right left
Input black Input white
points points
value value
Output black Output
pointnumerical Hrightriees white point
value harey numerical
value

Move upwards
Output black points

The horizontal axis shows the input level and the vertical axis shows
the output level.

@ The setting range of black points is 0 to 247 (in 1-stop increments
when entering a value).
The setting range of white points is 8 to 255 (in 1-stop increments
when entering a value).
You can display pre- and post-editing histograms (p.59).

Using the Auto Lighting Optimizer

For information on using the Auto Lighting Optimizer, see “Using the
Auto Lighting Optimizer” (p.53) in “Editing with the Basic Adjustment
Tool Palette”.
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JPEG/TIFF

Editing with the Color Adjustment Tool Palette

With the Color Adjustment tool palette, you can adjust the hue,
saturation and luminance in a specific color gamut for 8 color gamuts
(red, orange, yellow, green, aqua, blue, purple and magenta). You can
also adjust the hue and saturation for the entire image and tune
monochrome images.

Select an image in the main window, etc.

Display the Color Adjustment tool palette.

Tool palette

Color adjustment

Hue

Saturation

R
a @

Monochrome

Purple

l4=

Magenta

l4=

H
5
L
H
5
L
H
5
L
H
5
L
H
5
L
H
5
L
H
5
L
H
5
L

Editing with the Color Adjustment Tool Palette

Adjusting a Specific Color Gamut
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

H: Adjusts the hue.

S: Adjusts the saturation.

L: Adjusts the luminosity.

=]

Revert all adjustments to
the original settings

Color adjustment |

Hue _._ms
_._a

Monochrome

Saturation

Drag the sliders left
or right

Enter the values to set

Revert color gamut
Orange .
adjustments to the
- original settings
|4 g 9

Yellow

[

@ The adjustment ranges are as follows:

H: —20 to +20
S: —10to +10
L: —10to +10

R
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Adjusting Hue and Saturation for an Entire
Image
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

Hue: Move the slider to the right to make color tones more

yellowish, and to the left to make color tones more reddish.

Saturation: Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for
less intense colors.

]

Color adjustment

Revert all adjustments
to the original settings

Enter the values to set

Hue

Saturation

Drag the sliders left or
right

@ The adjustment range for hue is —30 to +30; and for saturation is 0
to 200.

Adjusting in Monochrome

Press the [Monochrome] button to set the 8 color gamuts to their least
saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.

]

Color adjustment

Hue

Saturation

Monochrome

——o—— [T 6

——o—— (TN 6
o—— [XNN 8
o—— [XH 8
o—— [XHN 8

——o—— [TEN 8

——o—— [THN 8

——o—— (TN 8

Drag the sliders left or
right

Revert all adjustments
to the original settings

Enter the values to set

 E———
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JPEG/TIFF e

Editing with the Detailed Adjustment Tool Palette Introduction

You can use the Detailed Adjustment tool palette to reduce the noise . . —
that occurs in images shot at night or at high 1ISO settings. This tool Reducmg Noise

palette can also be used in conjunction with the sharpness adjustment You can reduce noise that arises in images shot at night or with a high
functions. Note that you can use the functions in this tool palette with ISO speed

JPEG and TIFF images as well as RAW images. '

Contents

Select an image in the main window, etc.

Display the Detailed Adjustment tool palette.

—
Printing
Images
MNoise reduction p )
. . . rocessin
Reduce luminance nais Drag the sliders Large Numbgrs
- i of RAW Images
Reduce chroni= noise Enter a setting (In T —
AT e e [~ Y 0.1-stop increments) Rumioia
Reduce luminance nojse . . Lo Shooting
_.' 8 You can set a noise reduction level from within a range of 0 to 20.
i T The larger the setting, the larger the noise reduction effect. -
PA— ] The noise reduction effect can also be checked in the check Specifying
) Preferences
i Sharpress [, window.
e— e [ © Rerﬁatzr;(cel
Fineness e e m e
—_—

Threshold s () s m s

* NR stands for Noise Reduction.

Adjust an image.

Sub-window

Enlargement
display
position

Check window

Downloading
Images

——

Viewing
Images

Sorting
Images
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Y
ZQ)= Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.

@ If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.54).
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JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before cropping.

Select the image to be cropped.

Display the Trimming/Angle Adjustment tool palette.
You cannot make adjustments with the Trimming/Angle
Adjustment tool palette in a window that only shows thumbnails.

Adjust the angle of the image as needed.

Trimming/angle adjustment window
Largest possible

trimming range

WS G - B G
« HEms -+ EEEe
oo 8 veo [EEEG

EXa ¢

Drag (0.01-degree increments; adjustment range: —45 to +45
degrees)
Use the mouse (click A/V¥)to adjust the angle or directly enter
the adjustment angle (0.01-degree increments; adjustable
range: —45 to +45 degrees)

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image.

If you have only adjusted the angle of the image, the image will
be cropped at the largest possible trimming range.

Select a ratio and drag the trimming range.

Select a trimming ratio

Drag the trimming

range
The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

@ When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark I, the displayed
trimming range is based on the aspect ratio information.
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List of aspect ratios (width : height)

e |
1:1

3:2

2:3

4:3

3:4

5:4

4:5
16:9
9:16
Custom

[Free]:

You can crop an image to any size, regardless of
the selectable ratio.
[Custom]: You can crop an image at the specified ratio.

Return to the main window.
The trimming range frame is displayed in the cropped image
(p.134).
When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

? Cropped images

The trimmed range can be reverted to its original condition at

any time

A cropped image is displayed or printed as a cropped image.

However, since the image is not actually cropped, you can always

revert to the original image by clicking the [ [ lka3l] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.85).

Display of the cropped image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.134).

* Preview window:  The image is displayed in its cropped condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.

Printing a cropped image
You can print as a cropped image by printing it in DPP.

The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.83).

Images that have aspect ratio set will be displayed as cropped
images

When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
I, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EQOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.®

When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [ [ Ea3] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EOS 5DS R, EOS 5D Mark IV,
EOS 5D Mark Ill, or EOS 7D Mark Il and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually cropped, even for JPEG images.

Operate using the menu
Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the < 3 > key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration
correction functions and the Digital Lens Optimizer to correct lens
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

Select an image in the main window, etc.

Display the Lens Correction tool palette.

800

100.0 J>
0.0
0.0

100.0 J>

Shot settings

Unsharp mask

3.0

4.0

4.0

Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Note that you can only correct aberration in RAW images which have
been shot with compatible lenses. JPEG or TIFF images cannot be
corrected.

® To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.

@ Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.74).
You can also correct RAW images taken with the compatible lens
even when the extender is attached.
You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.
The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.

Peripheral illumination

Chromatic aberration (color fringing which occurs in the periphery of
an image)

Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)

Distortions Diffraction

Select an image in the main window.

Display the Lens Correction tool palette and
checkmark the items to be corrected.

Enlargement display section
— - ]|

e NN aE (85

The image is corrected and redisplayed.
In the main window, the [ 1] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.134).

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.

You can lessen the degree of correction by moving the slider to
the left.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.70).

For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
[Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera's
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.
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Introduction
Effects of Distortion Correction for Fisheye Emphasize Distance
This converts the image to an “equidistant projection” style image.
Lenses Content
This projection method preserves distance relationships. ontents
Shot settings Equidistant projection displays a distance in the same distance
By selecting this option, only the aberration corrections will be anywhere from the center to the periphery. In particular, when _
performed to correct the optical distortions. shooting a celestial body such as the celestial sphere, same heights D°‘|”n']‘;°ae°s"“9
above the horizon(declination) are captured at the same heights. This g

method is therefore used in such photography as celestial

photography (star maps, solar path diagrams, etc.). Viewing
Images
Sorting
Images
Editing
| S
Emphasize Linearity Printing
This converts the image to a “central projection” style image. This Images
projection method is employed for general lenses. ] ]
Since central projection displays straight lines as straight lines, a Emphasue Penphery . o _ Processing
wide-view panoramic image can be obtained by selecting this option. This converts the image to a “stereographic projection” style image. Iafaﬁvwn'?:;;:
However, the periphery is stretched, resulting in decreased resolution. This projection method emphasizes the periphery.
Stereographic projection allows position relationships on a spherical
' surface, such as N, S, E, W on a map, to be displayed correctly. It is sliemo_te
. / therefore used for world maps and monitoring cameras. e
By selecting this option, the periphery is stretched and may result in
decreased resolution. Specifying
' Preferences
B O <2
Reference/
Index
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Emphasize Center

This converts the image to an “orthographic projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

@When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection
method. However, the conversion does not really apply a change of
projection method in a strict sense.

Accordingly, be aware that they are not suited for scientific or other
such purposes.

Shooting Distance Information Slider

When correcting RAW images and if shooting distance information has
been saved to the image, the slider is set automatically according to
this shooting distance information. However, if no shooting distance
information is saved to the image, the slider is set automatically to the
right end at infinity position and a [<!>] appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the
correction items with check marks.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.
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Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.69).

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.87).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.63). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.64).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.50) and/or the color saturation (p.62) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability or
any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.68). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data] for
the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended

that you set [Sharpness] or [Strength] for [Unsharp mask] for images to O.

@ To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
[Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.
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Introduction

Click the [[lFFE] button. —_——

Using the Digital Lens Optimizer

Shooting distance information Contents
. —
Check the status of [Lens data] for [Digital Lens °
Optimizer]. Lens data : No Downloading
Images

Shooting distance information

Viewing
Images

®
The [Add or Remove lens data] window appears.

Lens data : No
Sorting
.0 B Images

[Not Available] is displayed for an image shot with a non- Edifing
compatible camera or lens, or for a non-compatible image such I s
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images. Printi
o . rinting
If [No] is displayed, proceed to step 2. To use the function, you Images
need to download the lens data for the lens used when shooting
the image. It is recommended that you check the lens used when Processing
shooting the image beforehand. The lens used can be checked Large Numbers
. . : . L . . of RAW Images
using the image information and shooting information displays.
If [Yes] is displayed, proceed to step 4.

—

|

Remote
Shooting

|

Specifying
Preferences

|

® To use this function, an environment with Internet access Reference/
(subscription to a provider, browser software installed and an in- Index
place line connection) is required. —

An administrator-level privilege is required for this operation. @ @

@ Before you click the [|jjifSll] button in step 2, Lens data [No] may ﬁ‘
be displayed instead of [Not Available] for non-compatible images. ~—



Checkmark the checkbox for the lens used to shoot

the image, and click the [Start] button.

8.00 Add or Remove lens data Version 1.4.20
Select a lens category
EI Ultra wide and wide [2] Macro [2] EF-M
@I Standard and medium telephoto @]Zoom
[ Telephoto M EF-s | Selectall | | Clearall |
Extender M EF1.4x M EF2x (] L lenses only

EF17-40mm f/4L USM
EF20-35mm f/3.5-4.5 USM
EF24-70mm f/2.8L Il USM
EF24-70mm f/2.8L USM
EF24-70mm f/4L IS USM
EF24-85mm f/3.5-4.5 USM

[ cerosmmipasose ]

EFZa=/70mm T/ £.8L USM
EF28-90mm f/4-5.6 USM
EF28-90mm f/4-5.6 |l
EF28-90mm f/4-5.6 Il
EF28-105mm f/3.5-4.5 USM

Checkmark the [Digital Lens Optimizer] checkbox
and adjust the image.
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EF28-105mm f/3.5-4.5 Il USM Shooting distance Information — )
EF28-105mm f/4-5.6 : Printing
| Destination Folder... | Add=1, Delete=0 | Cancel | Images
o & Lens data : Yes .
4 Digital Lens Optimizer B Reverts to its condition La?;zcﬁzrsy:ggrs
R — e 500 I before adjustment
The lens data is downloaded to your computer. o 100 fm
When the downloading of the lens data ends, the indication for
Remote
the lens data changes to [Yes]. Shooting
Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window. —._
. _ . ) Specifying
If you remove the check mark from the checkbox for already- ® Since the lens data downloaded with DPP version 3.x is not Preferences
downloaded lens names and click the [Start] button, the lens data compatible with DPP version 4.x, the lens data must be downloaded L
will be deleted from your computer. again.
Reference/
Depending on the type, current state, etc. of software running on Index

@ When applying the Digital Lens Optimizer, the effect of [Sharpness]

or [Unsharp mask] may become excessive. It is recommended that
If you want to change the destination where lens data is saved you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0
when there is already downloaded lens data, move the previously before using the Digital Lens Optimizer. Adjust [Sharpness] or @

your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.

downloaded lens data from the old folder to the new destination [Unsharp mask] again after applying the Digital Lens Optimizer to
folder manually. images. 24



Introduction

Use the slider to adjust the Digital Lens Optimizer effect. C—
If no shooting distance information is saved to the image, the Contents
shooting distance slider is set automatically to the right end at

infinity position and a [<!>] appears above the shooting distance ——

slider. _ ) _ _ _ Downloading
If the lens requires no adjustment with the [Shooting distance Images

information] slider, the slider cannot be used.
Images cannot be corrected for [Chromatic aberration] in the lens
aberration correction tool pallet if the Digital Lens Optimizer has

Viewing
Images

been applied.
In the main window, the [ﬁ] mark is displayed on the image to Sorting
indicate that the Digital Lens Optimizer is applied (p.134). Images
P liag
Adjusting Image Sharpness L

—

You can also use this palette to adjust the image sharpness. For -
information on making adjustments, see “Adjusting Image Sharpness” in 'I’l:::t'gsg
“Editing with the Basic Adjustment Tool Palette” (p.54). 9
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette

You can use this tool palette to erase dust and other marks in a shot ] . .
image and to correct an image by copying part of the image and pasting Performlng Automatic Dust Erasure Processmg
it onto an unnecessary part of the image.

Note that you can use the functions in this tool palette with JPEG and
TIFF images as well as RAW images.

The Dust Delete Data that is appended to images can be used to
automatically erase dust spots.

Select an image with dust delete data attached in the

Dust Delete/Copy Stamp Tool Palette main window, etc.

Display the Dust Delete/Copy Stamp tool palette.

H
=

You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails.

Apply Dust Defets Data When the image has redrawn itself, click the [Apply
(Light (Darkq) Dust Delete Data] button.

Select Copy Source

T P e e

B Fix Copy Source pasition
Pen type
© Brush ® rencil

Radius

Dust spots are erased in a single operation.

Return to the main window.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ Ea3] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.85).

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.78) or the copy stamp function (p.80).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.83).

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image from which you
want to erase dust spots.

Display the Dust Delete/Copy Stamp tool palette.

Click the point from where dust is to be erased.

Click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be

erased.
If the dust spot is dark in color, click the [ ] button,
and if the dust spot is light in color, click the [ EEEETIN |
button.

When you move the cursor over the image, the dust erasure
range is indicated with [O].

Place the dust spot to be erased within the [O] and
click.

Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots
within the displayed image.

To erase dust in another part of the image, click the button clicked
in step 4 again to cancel dust erasure processing and perform the
operation again from step 3.

When the dust spot cannot be erased, [@] is displayed.

Return to the main window.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.80).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ Lz38] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.85).

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.83).

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Introduction

Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Contents

. . . Downloading
Follow steps 1 to 3 in “Manually Erasing Dust (Repair Images

Function)” (p.78).

Viewing

Specify the section to be copied. Images

Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.

Lt

To change the section that is to be the copy source, perform the Isr:;tégg
operation above again.
To fix the position of the copy source, checkmark [Fix Copy :
Source position]. m
Correct the image.
Click or drag on the part of the image you want to modify. [+] in Printing
the window indicates the copy source and [Q] indicates the copy Images
destination.
The copied image is pasted in the position to which it was Processing
Large Numbers
dragged. , , of RAW Images
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
Remote
borders are sharp). Shooting
Return to the main window.
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Setting Work Color Space

A different work color space (p.136) from the default settings (p.129) can
be set for each image.

Display the Settings tool palette » select the color
space to be set.

Settings tool palette

Work color space

B Soft-proof colors
Profile : Settings...

—— MNone —

© Use printing profile
@ Use CMYK simulation profile

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.129), this
default setting will not be applied and the individually set color space will
remain.

-:\@/E The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function

By using the soft-proof colors function, you can apply a selected printing
profile or CMYK simulation profile to the displayed image. The reliability
of the soft-proof colors function depends on the monitor quality, the
monitor and printer profiles, and surrounding lighting conditions where
you are working.

Click the [Settings] button.
Tool palette

En .
=] o) 71

Work color space

B Soft-proof colaors
Profile : Settings...
— None —

© Use printing profile

@ Use CMYK simulation profile

The [Color management] tab sheet in [Preferences] appears.

Select the profile to apply from the [Printing profile]
or [CMYK simulation profile] list box, and click the
[OK] button.

Preferences

General settings _Image Processing L | Image Processin

TISIW] View settings
Default settings of Work color space *
(2)sRCR _)Apple RCB
Adobe RGB ColorMatch RGB
‘Wide Gamut RGB

Use shooting color space as work color space
Color marching ssttings
For display
Use the OS settings
Printing profile

(CMYK simulation profile
--- None

“Changes take effect after restarting Cancel

oK )

The [Color management] tab sheet in [Preferences] closes.

According to the profile selected in step 2, select
either [Use printing profile] or [Use CMYK simulation
profile], and checkmark the [Soft-proof colors]
checkbox.

Tool palette

Work color space

4 Soft-proof colors
Profile : Settings. ..
OO OO XX MK

© Use printing profile

@ Use CMYK simulation profile

The profile selected in step 2 is applied to the displayed image
including its thumbnail.

The profile is not applied to images displayed in the quick check
window.
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JPEG/TIFF

Saving Editing Results

Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu » desired item.

Save #S
Save As... {+88S

Convert and save... ¥D
Batch process... *B
Print... ®P
Print with detailed setting... 3P
Plug-in printing >
Select collection »
Delete collection »

Your adjustments are saved to the image.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Save H®S
Save Ac {+ 385
[Converl and save... §£D]
Batch process... =B
Print... #P
Print with detailed setting... 3P
Plug-in printing >
Select collection >
Delete collection >

The [Convert and save] window appears.
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Introduction

Specify the necessary settings, and then click the

[Save] button. Contents

By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.

Change the settings according to your requirements. .
, 9 9 gloy a Downloading
noo e Images
(save s fimc 0007 .—— Enter a file name
Tags:
(<> (e =[] m [~ ] (S 00003 s O V|ew|ng
e epcsions =weworc Images
B Docurens : — Select the save \
© Downloads : . :
i u: destination Sorting
e Images
(Saveasrype TIFF 16bit + Exif-JPEG (*.TIF, * JPG) :)lmagg“ualiw 1 10
utput resolution pi L 1 u
:\nesize I oo v Lock aspect ratio SeIeCt an Image E
Width 5472 % Height 3648 (5472 x 3648 pixel) Unit | pixel type |
¥ Embed ICC profile
Shooting info setting | Include all shooting info = |
New Folder Cancel —C||Ck and save Printing
G T the developing/editi Its for the versi e
: : : . 2= To save the developing/editing results for the version you are
The RAW image is converted to a JPEG or TIFF image which is currently using ping 9 y
then saved as a new image in the specified save destination. 1 Procﬁssigg
DPP’s RAW image development processing technology is continually o?'gﬁw?ma;;:
being improved upon so that you can perform the latest image
processing more appropriately.
Remote

Meaning that, between two different versions of DPP, processing results Shooting
may differ very slightly even if with the same RAW image data, or the

results of significant editing of RAW image data with an attached recipe
may be different. Specifying

When you want to save the developing or editing results of the version Preferences
you are currently using as it is, saving the image as a separate file (p.83)
is recommended. Reference/
@ By saving as a separate JPEG or TIFF image as explained Index
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.
By saving as explained above, a trimmed image (p.65) or dust-
erased image (p.76 to p.80) actually becomes a trimmed image
or dust-erased image. @
You can batch convert and save multiple images (p.115).



Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.41 to p.81), so the “original image data itself’
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.65) or dust-erased image (p.76 to p.80) is simply
saved to the image.)

For this reason, you can undo any adjustments saved (p.83) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left ®L
Rotate Right #R

Apply Dust Delete Data

Work color space >

Revert to last saved settings " ¥Z
Revert to shot settings ~3Z

The image reverts to the conditions of the selected item.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

"JPEG, TIFF image data |
Image processing conditions information

, . RAW i lmage data:
Image processmg conditions information

I \N
L.drd ]

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).

A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.

Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.

R
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Introduction

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image.

Saving a Recipe as a File

Select an edited image, and then select the [Edit]
menu » [Save recipe in file].

Contents

Select the image with the recipe you want to copy.

To copy all items of a recipe, select the [Edit] menu »
[Copy recipe]. To copy only selected items of a
recipe, select the [Edit] menu » [Copy selected
recipe].
The recipe is copied.
To select recipe items, select the [Edit] menu P [Select and copy
recipe settings] and select items in the window that appears.
After specifying settings, click the [OK] button and close the
window.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

@ When a recipe for an image is copied and applied to an image

in a different orientation, the image orientation also changes.

To prevent the orientation of the image from changing, select the
[Edit] menu » [Select and copy recipe settings] and remove the
check mark from the [Rotate left / Rotate right: 0°] checkbox in
the window that appears.

The [Save recipe in file] dialog box appears.

To save all of a recipe, select the [Save all recipes] option in the
window displayed.

To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the
[Specify Recipe Details] button. In the window displayed,
checkmark the recipe settings to be saved and then click the
[OK] button.

Select the destination folder, enter a file name, and
then click the [Save] button.
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Loading and Applying Recipes

Select the image to which a recipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select a recipe and click the [Open] button.
The recipe is applied to the image.
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JPEG/TIFF

Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

In the preview window, display the multiple images
to be compared.

Align the images.
Select the [Window] menu » [Arrange horizontally] or [Arrange
vertically].
The preview windows are aligned.

Select the [Preview] menu » [Sync preview position]
and [Sync preview display size].

Enlarge the image.
Enlarge and display any of the preview windows.

{iﬂ Ny~

Other preview windows will also be displayed in the same
position/enlargement ratio.

Move the area to be displayed.
If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
To cancel synchronization, select the [Preview] menu » [Sync
preview position] and [Sync preview display size] again.

@ Synchronization only applies to the enlargement display position

and the enlargement ratio. Adjustments to the images are not
synchronized.

R

Introduction

M —

Contents

N —

Downloading
Images

N

Viewing
Images

J

Printing
Images

|

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

|

Specifying
Preferences

|

Reference/
Index

N —

Q0

89

)



Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and
images can be edited efficiently while quickly switching between images
to be edited. Select the images to be edited beforehand in the main
window.

In the main window, select the images you want to
edit.

Switch to the edit image window.

r‘ Digital Photo Professional 4 File Edit View Thumbnails Preview
800

Edit Image Quick Check Remote Shooting

Bookmark v3
Click

The main window switches to the edit image window.

Edit image window

Profersional s FIR Gt Vie L

uuuuuuuuuuuuuuuuuuuuuuuuuuuuuuu

Edit the image.

sional 4 _file Edit View Thumbnails _Preview Label Adju:

Change the display magnification

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.134).

The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <38 > +
<Z> keys.
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Click the area you want to enlarge.

\t_ToolsWindow _Help D & = & Mon75LPM Q =
gital Mac

Click

The area you clicked is enlarged to 100% (actual pixel size).
To change the display area, drag on the image or drag the
enlargement display area (p.16) of the navigator palette.
Click again to revert to the full view ([Fit to window]).

To return to the main window, click the [] button on the
toolbar.

@ With the edit image window, you can only select images from a
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.92).

Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Horizontal Thumbnails].

Tl Phats Profession) EaT Ve Thumn T E e 4 wen7Ei Q=

Ema

If you select [Vertical Thumbnails], the thumbnail display reverts
to the vertical position.
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Gathering and Editing Images in the Collection Window

You can gather selected images together in Collection folders for
viewing, comparison and editing.

You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

Click [+ Add collection] in the [Collection] area in the
main window.

Collection

[ R ] IMG_0026.CR2

+ Add collection

A new collection folder is created in the [Collection] area.

Enter a name for the collection folder.

To create additional collection folders, repeat the operation. Up to
20 folders can be created.

Select the [File] Menu » [Select collection], and
select a collection folder to gather images from the
collection folder names displayed.

Select images or image folders in the main window.
Select the [File] menu » [Add to collection].

The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.20) is added, the
number of images is indicated as two images.

You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from

the menu that appears when you holding down the <control> key.

Select a collection folder in the [Collection] area.

Collection
B 0001(25)
= 0002(32)
i3 0003(25)

IMG_D027.CR2

{:_;‘:l —'_ fl:E‘l

-+ Add collection

Images in the selected folder are displayed.
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Check the displayed images.

(& Digial i iew _Label _Adjustment _Taols _ Wind
800

Edit the images.

Edit the displayed images.
Displayed images are retained in the collection folders even after
quitting DPP.

A/

s

@i— To remove images from collection folders

Removing selected images

Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, holding down
the <control> key, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.

Removing all images

Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.

Deleting a collection folder

Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears while holding down the
<control> key. Note that if you delete a collection folder, the original
images remain unaffected.

Modifications to the image are applied to the original image
Modifications made to images in a collection folder are all applied to
the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

5

This function can be used with all image types (p.3) supported by
DPP.

The color space of a composited image will be the color space of
the background image.
Image information is not appended to a composited image.

Select a background image in the main window.

Digital Photo Professional 4 — [lolder: Macintosh HD/Users/user/Pictures/xuoo]

Remote Shooting

IMG_0001.CR2 2 IMG_0002.CR2 2 IMG_0003.CR2 m 1MG_0004.CR2

Collection

+ Add collection

174 =EE= * T EEE@E <RER / ROR

You can also select a background image from the edit image
window or [Collection] window.

Select the [Tools] menu » [Start Compositing tool].

Tools

Start Rename tool

R

( Start Compositing tool

32X |

start HDK tool
Transfer to Photoshop

Thumbnail display filter settings...
AF point display settings...
Grid display settings...

Highlight/shadow warning display settings...

Preview properties display settings...

Settings for thumbnails with shooting info...

Preview screen display settings...
Customize toolbar...
Print button mode...

Y

~38P

The compositing tool window appears.

2]

N IMG_0001.CR2 [3456 x 2304]

“For image compositing, select an image to combine.

I 100% view

Foregraund Image

\‘ Select an image :]

Weight ]

Position
B

bl
5]

[ Continue |

[ Save As.. |

Close

R
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Select the image to combine.
Select the image to combine from the [Foreground Image] list
box.

-,

100% view
Select an image |
¥ IMG_0001.CR2
IMG_0002.CR2
IMG_0003.CR2
IMG_0004.CR2

Composite Method

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and [Foreground

Image] is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window:
images in same folder as background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can also combine images of different sizes.

Select a compositing method.
Select a compositing method from the [Composite Method] list
box.

| 100% view J

Foreground Image
| IMG_0002.CR2 3

¥ Add
Average

Lighten
Darken

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.97).

If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).

Introduction

M —

Contents

N —

Downloading
Images

—

Viewing
Images

Sorting
Images

Editing
| s

—

Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

Specifying
Preferences

\

Reference/
Index




Position the images.

[z Mals] IMG_0001.CR2 [3456 x 2304]

|

100% view |

| IMG_0002.CR2 :]

I Weighred

E”Eompn!&' in RAW Format

Weight 50.0
.
feanes [T
2
Al
RIKIELS
i
b

Continue |

Save As... |

| Close |

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.
[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

@ You can set [Compose in RAW Format] under the following

conditions.

Both the background image and [Foreground Image] are RAW

images, and all the following conditions are met.

» The cameras used to shoot were of the same model

» The ISO speed setting at the time of shooting was the same

» The highlight tone priority setting at the time of shooting was
the same

» The image sizes (original size) are the same

@ The following functions are not available for images composited

Shift large amount (50 pixels)
Shift small amount (1 pixel)
Align image centers

You can also directly enter the position
coordinates of the [Foreground Image]
to align it.

with [Compose in RAW Format].
* Auto Lighting Optimizer (p.53)

* Picture Style Auto (automatically set to Standard) (p.44)

R
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Click the [Save As] button.

Position

8

| Continue |

[| Save As... |]
Close

Specify the required settings in the window that appears and then
click the [Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The background image and [Foreground Image] are added and
images are combined.

Average

The background image and the [Foreground Image] are combined in
proportions of 50% each.

If you want to change the proportion of the [Foreground Image], select
[Weighted].

Weighted

Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
Darken

The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.

@ You can display this function as a function button in the main
window’s toolbar (p.106).
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JPEG/TIFF

Creating HDR (High Dynamic Range) Images

You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

@ This function can be used with all image types (p.3) supported by
DPP.
Image information is not appended to an HDR image.

Select an image in the main window.

000 Digital Photo Pro 4 - [Folder: tosh HD/Users ures 30000

Edit Image

Folder Bookmark
8 Applications
@ Library
| system
8 Temporary ltems

IMG_0001.CR2 B IMG_0002.CR2 B IMG_0003.CR2 I3 IMG_0004.CR2

Collection

=+ Add collection

s LD e > T B E SRGB [ SRGB

Select the [Tools] menu » [Start HDR tool].

Start Rename tool XR
iti | ey |
l Start HDR tool NRY
WIPLITTITLET U
Transfer to Photoshop ~HP

AF point display settings...

Grid display settings...

Highlight/shadow warning display settings...
Preview properties display settings...
Settings for thumbnails with shooting info...
Preview screen display settings...

Customize toolbar...

R
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Specify the required settings, then click the [Start
HDR] button.

8.0 Select Images
o e o s
= £ =3 S
IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2
‘ Browse... |i |[ Browse... l J Browse...
|| Auto Align
| Close ({ Start HDR |)

To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window
appears.

@ After using auto image alignment, the periphery of the images is
partially deleted.

Make required selections to adjust the image.

eno

IMG_0001.CR2/IMG_0002.CR2/IMG_0003.CR2

Adjust Image

Presets.

Natural 2]
Tone/Color
I
Brightness;(50)
|
Saturation:(50)
= N O
Contrast:(30)
el
Detall Enhancement
Strength:(0)
e
Smoothness:(0)

LJ
| Fineness:(0)
®
Save As... |
Y Close \

Sliders in [Adjust Image] window

[Tone/Color]

[Brightness]:

[Saturation]:

[Contrast]:

Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.
Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.
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[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.

[Natural]:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down vividness more than [Art standard],
for an old-fashioned feel.

Click the [Save As] button.

—

L

l

Save As...

Close

Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.

@ You can display this function as a function button in the main

window’s toolbar (p.106).
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Using the Dual Pixel RAW Optimizer

By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.

® Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
Common to all functions
« Effects are most easily gained when the lens aperture value is
/5.6 or lower.
« Effects may be different between shooting in vertical orientation
and horizontal orientation.
* It is recommended that the ISO speed be ISO 1600 or lower.
Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
* It is recommended that the lens focal length be at least 50 mm.
* It is recommended that this function be used when the camera
is at a distance from the subject.”
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m-10m/ 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx. 2 m-20 m /6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx. 4 m-40m/13.1 ft. - 131.2 ft.

@ You can display this function as a function button in the main
window’s toolbar (p.106).

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File

Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

800 [Users/user/Pictures /x000¢/IMG_0010.CR2 [6720 x 4480]

Zoom In 100%

() Image Microadjustment

Back : (0)

Front : (0)
Strength : (5)

() Bukeh Shift
Sclect area

7 Show bardars
Left : (0) Right : (©)

) Ghosti

Threshold : (1)

Cancel oK

Checkmark the [Image Microadjustment] checkbox.
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Adjust the image.

800 [Usersuser/Pictures [xxo00x/IMG_0010.CR2 [6720 x 4480]

 Image Microadjustment
Back : (0) \ LY

Front : (0) {
Strength : (5)

Bokeh Shift
Select a
V/ Show borders
Left : (0) Right : (0)

@ Sharpnass

Unsharp mask
Strength : (4) =
Finenass : (1) e

Threshold : (1) o u—

Cancel oK ]

Use the slider to adjust the resolution based on depth information
and the level of resolution.

Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.83).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“Reduces the appearance of ghosting in images”.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result

Reposition the viewpoint or foreground bokeh for a more pleasing resuilt,
using the dual pixel information recorded in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Bokeh Shift] checkbox.

Specify the area to adjust.

800 [Users [user/Pictures/xxox/IMG_0020.CR2 [6720 x 4480)

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Introduction

M —

Contents

S

Downloading
Images

Viewing
Images

Sorting
Images

Editing
| s

—

Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

Specifying
Preferences

\

Reference/
Index

Q0
)

—

102



Introduction

Adjust the image. .. ——
800 {Users/user/Pictures/xouoc/IMG_0020.CR2 [6720 x 4480] Red uces the Ap pearance Of G hOStI ng In Images
- = Zoom in 100% 5 C t t
i Reduce the appearance of ghosting in images, using the dual pixel oments
N —

information in Dual Pixel RAW images.

Strength : (5)

™ Bukeh Shift
Select area L)

lLeft:lm kiqm:rol'
L Ghosti
rea
ow borders

Threshold : (4)

Cancal (13

Use the slider to adjust the viewpoint.

Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.83).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

Resolution may expand in the depth direction according to the
level of adjustment.

If the border of the selected area in the image appears unnatural,
lower the level of adjustment.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Ghosting Reduction] checkbox, and
specify the area.

806 {Usersuser/Picturesfxo000:/IMG_0030.CR2 [6720 x 4480]

[l Image Microadjustment
Back : (0)

Front : (0)
Strength - (5)

-] Bokeh Shift
Select area
¥/ Show borders
Left - (0) Right - (0)

# Ghosting Reduction
Select area

 Sharpness
Unsharp mask.

Strength - (3) O—

Cancel oK )

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Any ghosting and flare in the specified area is reduced.
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Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.83).

There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.

There may be cases where the border of the selected area in the
image looks unnatural.

This function cannot be used at the same time as
"Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file" or "Reposition the viewpoint or foreground bokeh
for a more pleasing result".

Introduction

M —

Contents

N —

Downloading
Images

—

Viewing
Images

Sorting
Images

—

Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

|

Specifying
Preferences

R

Reference/
Index

Q0
)

—

104




Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
atime, see p.117.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.135) is added. The ICC profile
contains information about [Preferences] (p.129) or work color
space (p.81) set for each image as described and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.

Introduction

_—

Contents

Downloading
Images

Viewing
Images

Sorting
Images

=l

J

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Specifying
Preferences

Reference/
Index

Q0
©

105




Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main
window’s toolbar.
You can also change how the buttons are laid out.

Select the [Tools] menu » [Customize toolbar].
The [Configure Toolbar] window appears.

Select functions to display in the toolbar.

800 Configure Toolbar

Select items to show in the toolbar.

[g Print I|M|l
el Saue
[ Rename Tool ]|MI

Fhoroshop
Compositing Tool
Dual Pixel RAW Optimizer

LM Tl

IREE

Close

To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.

After specifying settings, click the [Close] button and close the
window.

The settings are applied to the main window’s toolbar.

 E———
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5 Printing Images

PrintinganImage .........ccoooiiiiiii i, 108
Printing with Shooting Information......................... 109
Printing a Thumbnail List (Contact Sheet

Printing) «oceeeeeeeieee e 110
Plug-in printing.........ccooeiiiii e 111
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the image to be printed.

Select the [File] menu » [Print].

Close window FEW
Save S
Save As... {+3S
Convert and save... $D
Batch process... )

(_Print... 32P)
Print with detailed setting... 3P
Plug-in printing >

Add to collection 50
Remove from collection {r 38
Clear collection

Select collection 3
Delete collection 3

Bookmark
Remove bookmark

Move to Trash 38 <&

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for printing photographs in the
printer’s print settings dialog box and click the [print] button.
Printing begins.

R
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

IMG_0001.CR2

Media orientation:
() Partrait

(») Landscape

Media size:
297.0 mm  x 209.9 mm
Print profile:

CMYK profile

I CMS settings...

| Apply ] | Cancel (‘ Print |)

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [[1]] on the [Text] tab sheet
and select the necessary items in the window that appears.

=Q< To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing
or the [Apply] button is clicked. The settings can be applied to another
image when printing.

Memorized settings are options in [Printer], [Media], [Media orientation],
[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.

@ You can set printer profiles (p.129).

If CMYK simulation is set, the image is printed in the set colors.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.
Select images to be printed in a thumbnail list.
Select the [File] menu » [Print contact sheets].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

Contact Sheet

r"-_] Image = Text Settings |

Printer: | Properties ‘

Media:
A

Media orientation:
(+) Portrait

() Landscape

Media size:
209.9 mm x 297.0 mm

Printing profile:

CMYK profile:

| CMS settings... \

| Apply il Cancel lr| Print |’

Print preview

-:\@/E To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.

Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.

@ You can set printer profiles (p.129).
If CMYK simulation has been set, the image is printed in the set
colors (p.129).
By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.
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Plug-in printing
Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for printing
photographs and then print.
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6 Processing Large Numbers of RAW Images

Batch Apply White Balance to Images (Personal White

Balance) ........ooeeiiii 113
Registering Personal White Balance......................... 113
Applying Personal White Balance ...............cccc......... 114

Batch Save as JPEG or TIFF Images (Batch

Processing)....cccoeuveeriiiiiiieeeice e 115

Batch Transfer Images to Image Editing Software ......... 117

Batch Change the File Name of Images................ 118
Changing the File Name of Images in the Order in the

MaIN WINAOW ... 118
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Personal white balance data for versions before DPP 4 cannot be
applied.

Registering Personal White Balance

Adjust the white balance (p.47, p.48).
To adjust white balance, select a setting other than [ ()] from
the [White balance adjustment] list box (p.46). Registering the
adjustments is not possible if [ ()] is selected.

In the Basic adjustment tool palette, click the
[Register] button.

The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

800 Register personal white balance

Register current setting in personal white balance

Destinationn | Load... |

| Sawve... |

| Cancel | ? To use the registered personal white balance on another
computer

In step 3, click the [Save] button to write as a file.

Copy the file to another computer.

In DPP on another computer, display the window of step 3.

Click the [Load] button and in the window that appears, select the
copied file.

You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Applying Personal White Balance

In the main window, select the image to which a
personal white balance is to be applied.

Select the [View] menu » [Tool palette].
The tool palette appears.

Click the personal white balance number button that
is to be applied.

Tool palette

Fine-tune

B A
B —— o=
A G
| | -——

Auto Lighting Optimizer |,

(= Standard Strong
Ficture Style
Y (landscape) - =
Gamma adjustment

B Linear
2 0

A0

. b ol
Personal white balance is applied to all the selected images.

R
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile

JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain

unaffected.

In the main window, select multiple images to be

converted.

Select the [File] menu » [Batch process].

The [Batch settings] window appears.

Specify the required settings, and then click the

[Execute] button.

Batch settings

Destination folder

IMC_0002.CR2 (%) Same as original files

'mg—gggi-ggs | Use this folder

Il & = "

IMC_0005.CR2 Macintosh HD/Users/user/Pictures

IMG_0006.CR2 || Create storage subfolders for each file type
IMG_0007.CR2 Exif~JPEG - | Subfolder name |PEC
IMG_0008.CR2

IMG_0009.CR2 Output setting

IMG_0010.CR2

IMG_0011.CR2 Save as type | Exif-JPEG (*JPC) | Image quality
IMG. 0912, CR2 Output resolution 350/ dpi

IMG_0013.CR2 ) S
IMG_0014.CR2 I Resie v/ Lock aspect rati
IMG_0015.CR2 Width 5472 % Height 3648 (5472 x 3648 pixel) Unit | pixel
iMEL S LACRa [ Embed ICC profile

IMG_0018.CR2

M U0L3.CR2 Shooting info setting | Include all shooting info |
IMG_0020.CR2 —
IMG_0021.CR2

IMG_0022.CR2 P16 e

IMG_0023.CR2 —

IMG_0024.CR2 (#) Current file name

IMG_0025.CR2 {_)New file name

IMC_0026.CR2 String Sequence number  Additional string
IMG_0027.CR2

IMG_0028.CR2 ¥ Save serial her
IMG_0029.CR2 S
IMG_0030.CR2 Ex.: IMG_0001JPG, IMG_0002 JPG

MG 003102 |mage transfer settings

IMG_0032.CR2

IMG_0033.CR2 | Open image using software

Convert RAW images only

) 10

Browse
‘ Lancel

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the

batch processing dialog box.

In the processing dialog box, click the [Exit] button.

If you have selected [New file name] in [File name], [Sequence
number] has to be set.

By saving as explained above, a trimmed image (p.65) or dust-
erased image (p.76 to p.80) actually becomes a trimmed image
or dust-erased image.

You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
converted and saved.
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? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.83) to edited RAW images.

A/

5@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.

-:@/3 Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike Select Photoshop.
“Transferring a RAW Image to Photoshop” (p.105), you transfer images In the [Open] dialog box, select a Photoshop file or an alias and
that have first been converted and saved as a separate image, so the click the [Open] button.

transferred image will not be deleted after quitting the destination

software. The software used here as an example is Adobe Photoshop. The [Open] dialog box closes and [Image transfer settings] in the

[Batch settings] window is set to Photoshop.

In the main window, select multiple images to be Click the [Execute] button.
transferred. The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop starts up

Select the [File] menu » [Batch process]. and transferred images are displayed in transferred order.

The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Checkmark [Open image using software].

Batch settings

IMG_Q001.CR2 Destination folder

IMC_0002.CR2 \g-"Same as original files

IMG_0003:CR2 ) Use this folder

IMG_0004.CR2 - -

IMC_0005.CR2 Macintosh HD/Usersuser/Pictures

IMG_0006.CR2 |_| Create storage subfolders for each file type

IMG_0007.CR2 Exif-JPEG Subfolder name |PEC

IMG_0008.CR2

IMG_0009.CR2 Output setting

IMG_0010.CR2 — ]
IMG_0011.CR2 Save as type | Exif-JPEG (*JPG) :| Image quality 10
IMC. 0012 CRe Output resolution 350/ dpi

IMC_0013.CR2 N »

IMG_0014,CR2 | Resize V' Lock aspect rat

IMG_0015.CR2 Width 5472 x Height 3648 (5472 x 3648 pixel) Unit | pixe!

it [ Embed ICC profile
IMG_0018.CR2
IMG_0019.CR2
IMG_0020.CR2
IMG_0021.CR2
IMG_0022.CR2 e her
IMG_0023.CR2
IMG_0024.CR2
IMG_0025.CR2
IMC_0026.CR2 String Sequence number  Additional string
IMG_0027.CR2 0000000

IMG_0028.CR2
IMG_0029.CR2
IMG_0030.CR2
IMG_0031.CR2
IMG_0032.CR2
IMG_0033.CR2 ( _| Open image using software )

Shoating info setting | Include all shaoting info |

(=) Current file name
(_)New file name

Ex.: IMG_0001.JPG, IMG_0002 JPG

Image transfer settings

@ To reset the transfer destination to another software, click the
[Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
button.

You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
transferred.

Convert RAW images only Cancel | Execute |

The [Open] dialog box appears.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

{Users/xxx/Desktop/xxxxx_03

DPP ~ | [Shooting Date/Time | 7| [Sequence number |~} Do not change [+

("I Copy and Rename Browse
Macintosh HD/Users/xxx fPictures

Original File Name Modified File Name

IMG_0001.CR2 DPP_08-08-12_0001.CR2
IMG_0001JPG DPP_08-08-12_0001JPG
IMG_0002.CR2 DPP_23-06-12_0002.CR2
IMG_0003.CR2 DPP_09-08-12_D003.CR2
IMG_0004 CR2 _, |DPP_10-08-12_0004.CR2
IMG_0005.CR2 DPP_10-08-12_0005.CR2
IMG_0006.CR2 DPP_12-08-12_0006.CR2
IMG_0007.CR2 DPP_12-08-12_0007.CR2
| MG_ooo8.cr2 DPP_12-08-12_D00B.CR2
IMG_0009.CR2 DPP_13-08-12_0009.CR2

cancel [| Execute

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is
duplicated. Changes cannot be made if even one file name is
duplicated. Change the settings so that duplication does not occur.

@ You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.

You cannot start up the rename tool from the [Collection] window
(p-92). You also cannot change the file name of one image.

Changing the File Name of Images in the
Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.33).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

[Users/xxx /[

File name

DPP __' | | Shooting Date/Time

Basic Settings
Sort

(=] Fit to main window
|__IFile name

[_Shooting Date/Time

Specify the required settings.
To copy an image, checkmark [Copy and Renamel].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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7 Remote Shooting

Remote Shooting..........ccoooiiiiiiiii,
Registering Click White Balance in the Camera
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Remote Shooting

You can perform remote shooting by using “EOS Ultility” which enables
communication with a camera in combination.

For remote shooting, “EOS Utility Ver. 3.x” must be installed on your
computer. For information on cameras compatible with “EOS Utility Ver.
3.x”, refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual
in PDF format). This function is not available on EOS M series cameras
or PowerShot cameras.

Click the [Remote Shooting] button on the toolbar in
the main window.

r‘ Digital Photo Professional 4 File Edit View Thumbnails Preview Label Adjustmer|

Edit Image Quick Check Remote Shooting

Folder Bookmark

B Macintosh HD
B Applications
@ Library
8 System

Remote shooting setting window appears.

Set the [Destination] in the Specify Remote Shooting
Folder window.

Specify Remote Shooting Folder

Destination

() Current Folder
Macintosh HD/Users / xeoooe f 30000 | 3000

(*) Use this folder

Macintosh HD/Users / xo000 / 3o | Select... |
Destination folder
XXXXX
File Name
Do not modify ]I Settings... |
| Cancel [ ok |

To save to the currently selected folder, select [Current Folder].
To create a new folder for saving images, select [Use this folder],
click the [Select] button, then select the destination and enter a
name for [Destination folder].

After specifying settings, click the [OK] button.

The remote shooting window appears.
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Introduction

@ You can change the [File Name] for Specify Remote Shooting
Folder window.
(If [Do not modify] is selected, images are saved with the file names
set on the camera.)

Contents

S

Downloading
Images

Click the [Settings] button to display the Set file name for captured
image window.

Set file name for captured image

Viewing
Images

| Do not modify || Customize...

File Prefix IMG

Sorting

Assign Sequence No.
Images

Mumber of Digits
\—.
Start

Shooting Date Format | Day Month Year + | Delimiter | Underline

Editing
Images

(DO-MM-YYYY ¢ ) You can perform shooting while checking the image by switching
the window to multi-layout. ————

Printing
Connect a camera and a computer, and set the Images

camera’s power switch to <ON>.

Cancel ok ] Processing

Click the [Live View] button. of AW Images

Select a naming rule for image file names from the list box.

You can click the [Customize] button and customize naming rules Camera Control
for file names. Exhers
You can individually set prefix characters, number of digits for
serial numbers, and the start number for file names. A
If you are using the shooting date in file names, you can specify Chiting o0 ) __ Specifying
the date format (order and style for year-month-date) and bl sl b Preferences
dividing characters on the Set file name for captured image Create subfolder I
window. .
Registered 1o
After specifying settings, click the [OK] button. Relﬁair)n(cel
The Set file name for captured image window closes. 0 |
Atfter clicking the [Remote Shooting] button, you can click the
[[]} ] button at the bottom right of the main window to show/ Satviogs Lo VoW @ @
TR e [CEmmere Cam ] pellziie. Live View window of “EOS Utility” appears.
|
D
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Specify the required settings.

800 Remote Live View window

T T

White balance

¥ Apply to shot images

: [on | orr.
LIl < 0> M0 oo el
Depth-of-field preview

(Sjofnfc) Jm- ] GsGe)

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

Click the [Settings] button.

ntrol

Camera

EOS XXX

1/50 F4.0 1S0400

Destination

Macintosh HD/Users /3x

Create subfolder

Registered to

0

Settings Live View

The capture window of “EOS Utility” appears.

Specify the required settings.

o EREA LG

Picture Style Standard
Detall set. 3,0,0,0
Regisier User Defined siyle

ality
SHIFT

[ rcerences.. B b wndow. |

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

Take the picture.

Camera

EOS XXX

1/50 F4.0 150400
Destination
Macintosh HD/Users/xx

Create subfolder

Registered 1o

0000000

R
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mmmmm

=========

The shot image is displayed.
The shot image will be saved in the folder created in step 2.
The images in the folder mentioned above will be displayed in
the thumbnail display area.

You can also create a sub-folder in the folder mentioned above to
save images. To create a sub-folder, click the [Create subfolder]
button on the remote shooting window, enter [Folder name] on
the screen appeared, then click the [OK] button.

® Do not quit “EOS Utility” when remote shooting is being set or

5

performed.

In the cases below, perform shooting with EOS Utility.

* You want to autofocus with EOS Utility’s shoot button

* You want to perform continuous shooting

You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.18). This is convenient for
image selection.

Registering Click White Balance in the Camera

During remote shooting, you can register click white balance to the
connected camera. To use this function, EOS Utility version 3.4.20 or

later must be installed on your computer.
This function is not available on EOS M cameras or PowerShot
cameras.

Display the shot image to be used as the standard
for white balance.

=T

This function supports only RAW images with a “.CR2”
extension.

Select the destination where to register click white
balance.

Camera Control

Camera

EOS XXX

1/50 F4.0 150400
Destination :
Macintosh HD/Users [ xxx/Pictures
Create subfolder

Registered to

LRSS =

Seléct the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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Introduction

Select a point that is to be the standard for white —
balance in the shot image, and register the white s
balance in the camera.
Camer:::: — Downloading
images

—_—
1/50 F4.0 150400

Destination :

Viewing

Macintosh HD/Users f xx/Pictures Images
Create subfolder
Sorting
Registered 1o Images
—
A0
Editing
Images
Settings Live View
Click the [[lEZZ=H ] button, and in the displayed image in step 1, Printing
click on a point that is to be the standard for white balance with Images
the mouse. .
The white balance is registered to the destination selected in La':;:"ﬁzmggrs
step 2, and applied to displayed images. of RAW Images
Click [[lEZT=H ] again to exit the function. S
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Specifying Preferences..........cccccooveeiviiiiiiiiiieeeennnn.

General Settings.......coovvviiiii i,
IMage ProCesSING .....ccuviviiiiiiieeeeeee e
Color Management.............ooovvvvvieiiieiieeeeiiiieieineenenenns

View Settings

8 Specifying Preferences
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Refer to the detailed explanations if available, as well as to each
window.

Select the [Digital Photo Professional 4] menu »
[Preferences].

The [Preferences] window appears.

Select a tab sheet, specify the settings, and then
click the [OK] button.

(%) Last displayed folder
() Specified folder

Preferences

Image Processing 1 | Image Processing 2 Color management | View settings | ]

Startup

Macintosh HD/Users/user/Pictures Browse

Save recipe
(+) Display message when adding file
") Add to file automatically
Movie file playback
Play with EOS MOVIE Utility
Movies that cannot be played with EOS MOVIE Utility are passed to the default application.
Receiving files from external applications
|_| Automatically focus files received
Default value of output resolution *

350 dpi(1-60000)

Temporary Files*

Currently used 0.8 MB | Delete | |  Reset |
Amount of Dual Pixel RAW cache used 282.1 MB | Delete |

Maximum available on disk 4G 0 — " 32 | Browse... |
Destination Macintosh HD/Users/user/Library/Application Support/Canon_Inc_IC

*Changes take effect after restarting

concel

General Settings

You can specify the folder that opens when DPP is started up, saving of
recipes, etc.

Preferences

SN Image Processing 1 Image Processing 2 | Color management | View settings |
Startup folder *

(#) Last displayed folder
() Specified folder

Macintosh HD/Users/user/Pictures Browse

Save recipe
(=) Display message when adding file
(") Add to file automatically
Movie file playback
Play with EQS MOVIE Utility
Movies that cannot be played with EOS MOVIE Utility are passed to the default application
Receiving files from external applications
|| Automatically focus files received
Default value of output resolution *

350] dpif1-60000)

Temporary Files*

Currently used 0.8 MB | Delete | | Reset |
Amount of Dual Pixel RAW cache used 282.1 MB | Delete |
Maximum available on disk 4CB 0 — > 32 | Browse... |
Destination Macintosh HD/Users/user/Library/Application Support/Canon_Inc_IC

*Changes take effect after restarting Cancel | oK |

Movie file playback
You can change the movie playback application to EOS MOVIE Utility.
Movies that cannot be played back with EOS MOVIE Utility are played
back with the movie playback application specified with the computer’s
OS settings. For detailed instructions on EOS MOVIE Utility, refer to the
EOS MOVIE Utility Instruction Manual.

@ If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.

If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.
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Default value of output resolution
When saving JPEG or TIFF images created by converting RAW images
(p.83, p.115), the resolution of the JPEG or TIFF images can be set.

Temporarily saved files
You can delete temporarily saved files that were created and improve
operation speed, change file save destinations, or set a limit on disk
usage. Any changes you made will be applied when you start up DPP
again.
[Delete] button: Click the [Delete] button to delete
temporarily saved files.
[Maximum available on disk]: Set with the slider (setting range: 0 to
32 GB).
Once usage reaches the limit, files
are erased starting with the oldest.

[Destination]: Click the [Browse] button to change
the save destination in the dialog that
appears.

[Reset] button: Click the [Reset] button to revert all

changes to the original settings.

Image processing
You can specify settings for processing images in DPP.

Image Processing 1

Preferences

| General settings Gl Image Processing 2 | Color management | View settings |
JPEG image quality *
|| Remove block noise and mosquito noise
Modified Picture Style settings *
(¥ Retain settings of each Picture Style
Preview image settings

[ Show stamp editing status on preview images

Select to show stamp editing status on all preview screens.
Clear to show stamp editing status only on the stamp editing screen

Noise reduction defaults*

(+) Apply camera settings Applies to RAW images enly
() Set as defaults

Reduce luminance noise 0.0
Reduce chrominance noise 0.0

Sharpness defaults™

(=) Apply camera settings Applies to RAW images only
() Set as defaults

Unsharp mask
Strength 0.0
Fineness 0.0

Threshold 0.0

*Changes take effect after restarting Cancel [ OK |

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.83, p.115) and for JPEG images that to
be saved with a different name. The higher the JPEG image’s
compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings
If you checkmark the checkbox, setting values for [Color tone], [Color
saturation], [Contrast], [Unsharp mask], [Sharpness], and other options
will be retained for each Picture Style.
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Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.

For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.

Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
When [Apply camera settings] is selected, you can pre-set a

sharpness that suits the camera settings beforehand as the default.

When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.

For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.

For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

Image Processing 2

:iz | Color management = View settings |

[_] Use graphics processor for image processing

*Changes take effect after restarting Cancel

2

Quick check window settings
You can specify image display settings for the quick check window. By
selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.

Graphic processor settings
If you checkmark [Use graphics processor for image processing], the
graphics processor is used to allow a faster preview display. The CPU
handles convert and save tasks as well as print tasks as usual. Settings
will be applied the next time DPP is started up.
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To use this function, a NVIDIA CUDA (Compute Capability 2.0 or
higher) GPU* with at least 1.0 GB of video memory is necessary.
Additionally, the latest NVIDIA GPU driver must be installed.

* GPU is an abbreviation of “Graphics Processing Unit”.

The [Use graphics processor for image processing] checkbox is
available only when a supporting GPU is installed.

If the OS or other application software is using the GPU,
processing by the GPU may not be possible in some
circumstances. In such a case, the CPU handles processing as
usual.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Prefarences

| General settings  Image Processing 1 | Image Processin: W View settings |

Default settings of Work color space *

(+) sRGB (") Apple RGB
(") Adobe RGB (") ColorMatch RGB
(") Wide Gamut RGB

[_] Use shooting color space as work color space

Color matching settings
For display
Use the OS settings
Printing profile Rendering intents

| ——- None —-—- o Perceptual
+) Relative Colorimetric

CMYK simulation profile Rendering intents

| === None -—-- o Perceptual
*) Relative Colorimetric

*Changes take effect after restarting Cancel | OK

Default settings of Work color space

You can select the color space (p.136) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved (p.83,
p.115) or printed (p.108 to p.111).

If you change the color space, and you restart DPP, the set color

space is applied as the default color space.

You can check the color space that is set in an image in all windows

except the quick check window.

If you checkmark [Use shooting color space as work color space],

the color space specified with the camera when the image was shot

will be set as work color space.
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A/
~ -

:@: Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, cropped, dust-
erased) images. Change the settings individually.

@ You can set a color space that is different from the default settings
for each image (p.81).

Printing profile (color setting of the printer)
Where a profile is not attached to the printer you are using to print
images, you can print an image, simulating the colors displayed on
screen by setting the profile in DPP.

@ When you set a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.

View Settings

You can set layout for screen display.

Preferences

{ General settings __Image Processing 1 __Image Processing 2 | Color management

Thumbnail order
[V Retain sort order
Clearing this option will discard the order of any thumbnails you have rearranged, in all felders.
Tool tips

(¥ Show tool tips

(=) Single-click () Double-click

*Changes take effect after restarting Cancel

2

Thumbnail order
You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.33).
If you checkmark the checkbox, the order of the rearranged images is
maintained even if you quit DPP or select another folder in the folder
area.
If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you quit DPP or
select another folder in the folder area.

Reset user interface
You can reset user interface settings.
Choose from either of 2 reset states.
By checkmarking the [Restore defaults at startup] checkbox, settings
revert to their original settings for next time you start up DPP. The
checkmark is also removed from the checkbox for the next startup.
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Troubleshooting

If DPP is not operating correctly, refer to the subjects below.

Installation can not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the User’s Manual for the Macintosh
computer you are using or for OS.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Quit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
may not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility.

Images are not displayed properly

Images that are not supported by DPP are not displayed. (Thumbnail
images are displayed as [?].) There are various types of JPEG and
TIFF images, so JPEG images other than Exif 2.2, 2.21 or 2.3
compatible images and TIFF images other than Exif compatible
images may not to be displayed properly (p.3).

A recipe could not be pasted (applied) to another image

Contents that can only be adjusted for RAW images cannot be
applied as a recipe to JPEG images or TIFF images.

Colors are subdued in the image when viewed with
other software

If a RAW image which has a color space other than sRGB is
converted and saved as a JPEG or TIFF image (p.81, p.129),
the colors will be subdued when viewed in software that is only
compatible with sRGB color space. In such a case, set the RAW
image’s color space to sRGB, convert and save again as a JPEG
or TIFF image, and then view the image.

The Auto Lighting Optimizer (p.53) is a function compatible with
cameras equipped with the Auto Lighting Optimizer.

Adjustments made with the Auto Lighting Optimizer cannot be
applied to RAW images shot with the cameras not compatible with
this function.

The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if the profile for a printer that is to print image is not set
up, the color of the image displayed on screen and the color of the
printed photograph may differ greatly. If the color of the monitor that
displays images is corrected (p.129) and the profile for a printer is set
up correctly (p.129), the color of a printed photograph and the color of
an image on screen can be more closely matched. Using a Canon
printer automatically sets up the profiles for the printer, so you only
need to set the color of the monitor to bring the colors closer to each
other.

Printing a large number of images in batches
cannot be performed
If a large number of images are printed in batches, printing may stop

in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.
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Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

Drag the folder for the software to be uninstalled to
the Trash.

Select the [Finder] menu on the desktop » [Empty
Trash].

The software is deleted.

When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.

R
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Image Frame Information in the Main Window and Edit Image Window (.11, p.20)

Trimming (cropping) range*2 (p.65)

Multiple image display mark
(p.19)

Check mark (p.30, p.31) Pinned image setting mark
(p.18)

INHG_D003.CR2

IMG_0030.CR2

File name

Image type

Rating mark (p.30, p.31) GPS mark 3 Lens aberration correction mark (p.69)

Digital Lens Optimizer mark (p.73) L Unsaved editing content mark

+ Displayed on RAW+JPEG images displayed as a single *3 Displayed on images shot on a GPS function-
image (p.12). compatible Canon camera.
[[[R]]is displayed in RAW images
[[TFR]] is displayed in Dual Pixel RAW images.

*2 When aspect ratio information is attached to an image [] is displayed in an image frame when editing is not possible.
shot with any supported camera other than the EOS 5D
Mark 11, the image is displayed as a cropped image.
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Glossary
RAW image

EOS camera RAW images are recorded in an uncompressed 14bit or
12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

Standard color space for Windows. Widely used for
the standard color space of monitors, digital
cameras, and scanners.

A wider color space than sRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

ColorMatch RGB : A slightly wider color space than sRGB. Mainly

used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Y

0.8

sRGB
—— Adobe RCE
-------- Apple RGB
————— ColorMatch RGB
———— Wide Gamut RGB

Color range that can be
seen by the human eye

08 X
Gamma White point
value (color temp.)
sRGB 2.2 6500K(D65)
- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
—————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.

Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index

A
Adjust JPEG IMagES......uuuuuiiiiiiiiiiiiitiiiiitennaeaeraaeeaaeeaeeenneennenane 41
AdJust TIFF IMages......cooiiiiiiiieie e 41
Adjusting
Adjustment Contents (ReECIPE) .....ccuvvvieiieeeiiiiieieee e 88
Apply AdJuStMENts.........ooveii s 87
Automatic Adjustment (Gradation, Luminance)............cccccccuvnnnnns 52
BrightneSsS .. 43, 56
Brightness of Highlights............coooiii e, 49
Brightness of Shadows............cooviiiiiiii e 49
Click White BalancCe ..........coooiiiiiiiiiiiiiiieeeee e 47, 57
Color Saturation .............cccccuvueeiiiiiiiiiiiiiie e 50
1070 ] (ol il =10 0] 0 1=T =1 (0] T 48
(©7 ] (o N o) = TSP 50
1076] 011 7= 1) ST 49, 56
Copy AdJUSTMENTS ....oeiiiiiiiiii e 87
DynamiCc RaNGe........coooiiiiiiiiiiiiiii e 51, 60
Filter Effect ... 51
[ 1 1< SRR 61, 62
MONOCKHIOME ... 50, 62
Personal White Balance ... 113
Picture Style File .....evveeiiieieeeeeeeeeeeeeeeeeeeeeeeeeeee e 46
SaAtUratioN ..o 61, 62
Save AdJUSIMENTS ........uvuiiiiiiiiiiiiiiiiiiiii e 87
SNAIPNESS ... 54
Tone Curve Adjustment..........cooiiiiiiiiie e 58
Toning Effect ... 50, 51
White BalanCe ... 46
Adjusting Brightn@ss .......coooiiiiiiii e 43
AdJusting TONE CUIVE .....coiiiiiiiiece e 58
Adjustment Contents (RECIPE) ......ccovvviiiiiiiiiiiiiiiiiiiiiieeeee e 86, 135
AdODE RGB ... 136
AF POINTS .. 19
F Y o] o LT R {1 = 136
AITange IMAGES ......uviiiiiiiie et 32, 33
Auto Lighting Optimizer.........ccevviiiiiiie e 53
Automatic Adjustment (Gradation, Luminance) ...........ccccccoviiviinennnn. 52
Automatic Dust Erasure Processing ..........ccceeevviiiiiieeeiiiiiiieieeeeeeeeennns 77

B
Basic Adjustment Tool Palette.............ccccuuiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeee 43
Batch Apply White Balance to Images (Personal White Balance)..... 113
Batch Change the File Name of Images..........cccccccciiiiiiiiiiiiiiiinnes 118
Batch Convert/Save Images (Batch Process) .........ccccccevvveeeeennnneee. 115
Batch Process (Batch Save JPEG and TIFF Images).........cccceuue...... 115
Batch Process of Multiple Images
Change File Name ........coooiiii e 118
Convert/Save (Batch Process)..........cc.cccoivieiiiiiiiiiniiiccics 115
Personal White Balance..........ccccccoooeii 113
Recipe Data .....oooovvvieiiiiii 86
T ANST O .. e 117
Batch Settings WIiNndOW....... ..o 115, 117
Batch Transfer Images ........ccoooooiiiii s 117
Batch Transfer Images to Image Editing Software..............cc.ceeeeeee. 117
Before/After Comparison Display .........cooooiiiiiieiiiiiiiiiieeee e 21
DIt NUMDEr ... 135
BOOKMArK ... 37
BrIGNTNESS. ... 56
C
Change File Name..........oooiiiiiiiiiiieeee e 118
Change the Display ..........cceevieiiiiiiiiiiiee e 11
Changing the File Name of Images in the Order in the
=1 AV 0T [0 1SR 118
CheCK MarK .......cooieiiiiiieeeee e 30, 31, 134
Chromatic Aberration Correction ...........ccoooiiiiiiciiiies 69
Chrominance Noise Reduction............cccccoeiiiiiiiiiiii i 63
Click White BalanCe.........ooeeeeeeeeeeeeeeeeeeeee et 47,57, 123
CMYK SImMUIAtioN ... 136
Collection WINAOW ........coooieiiiii i 92
Color Blur Correction ... 69
Color Chart ... 136
Color Management (Color Matching) ........ccccvveeeieeeeiiiiiiieee e 135
COlOr SPACE ... bbb 136
ICC PrOfil€S ... 135
Color Management (Preferences) ......ccccoovcceieeiiee e 129
Color saturation ... 50
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Color Setting of the Monitor (Profiles)...........cccceveeeiiiiiciiieee e 129
Color Setting of the Printer (Profiles) ..o 129
Color SPaCE ....coooveiiiiii 136
AdODBE RGB ... 136
APPIE RGB ... 136
Color Space Setting for Each Image .........ccccccevviiiiiiienieeiiie 81
(O70] [o]4 1Y/ F=1 (1 I 2 €1 = S 136
SRGB... .. a s 136
Wide Gamut RGB........coooiiii, 136
Color Space Setting for Each Image.............cccouiiiiiiiiiiiiiiiieeeeeeee 81
Color Temperature...........oooe e 48
(©70] o] gl 1o 1= TSP RERPR 50
ColorMatch RGB.........oeeeeee e 136
Compositing IMagES .......uueeiiiiiie e 94
[076] 011 7= 1) AU TR 49, 56
Convert ONe IMage.......c.uueiiiieiieeee e 83
Convert to JPEG or TIFF Image and Save.............ccoeeeeeiieeenn. 83, 115
Copy Stamp (Image Correction) ... 80
Copying and Pasting (Applying) RecCipes..........ccccveveeiiiiiiiiiiiieeeeees 87
Correct Images (Copy Stamp Function) ..................cc 80
CrOPPING oot 65
Customize toolbar ..., 106
D
Default Color Space Setting........ccuvveiiiiiiiiiie e 129
Delete IMages........ooooei i 36
Deleting
Delete IMages ....ccooeeeeiiie e 36
Delete the Software...........ccoovvvevviiiiiiiiiiiiiiieeeeeeee e, 133
Deleting DPP (Uninstalling) .........ccoooiiiiiiiiiiee e 133
Detailed Setting Printing (Printing with Shooting Information) .......... 109
Diffraction Correction ... 69
Digital LeNS OptimMizZer........cooiiiiiiiiiiiieee e e e 72
Digital Lens Optimizer mark..........coooioiiiiiiiiiiicccc s 134
Display
Before/After Comparison Display ........cceeeeeeieiiiiiiiiiieiieeeeeeie 21
Enlarged Display (Preview Window) ..........cccccvvvviiiiiiii, 15

Enlarged Display (Quick Check Window) ...........ccccceeeiiiiiiiieeennnn. 28
Multi-Function Preview...........cccoviiii 22
Single Image Display ... 33
Synchronize Preview WiNdOW..............uuvvvieeiieeeieiieeeeeeeeeeeeeeeeeeeeee 89
Thumbnail Display (Main WindOw)..........ccccceeiiniienienniinneinnnnnnns 11
Thumbnail Display and Enlarged Display
(Edit Image WINAOW)........cuuviiiiiiiiieieeeeeeeeeeeeeeeeee e 90
Displaying Image PropertieS..........ccoovvuiiiiiii e 21
Displaying Shooting Information...............cccuiiiiiiiiiiiiiie, 21
Distortion CorreCtioN............uuuuuuiiiiiii e 69
Downloading an Image to Your Computer ...........ccoeeiiiiiieiiiiiiiiiiieee, 9
Downloading Images froma Camera ...................cccooeee. 9
Downloading Images from a Card Reader.............................l. 9
Downloading IMages ........ooouuiiiiii e 9
Downloading Images from a Camera............cccccvvvvvvnuiivniinniiiniieniennnnnnn, 9
Dual Pixel RAW Optimizer.........ccccocieuiiiiiiiiiiiiiiiiivieiieeeeeevveveeeeeeeeeees 101
Dust Delete Data .........oooeeiiieeeeeeeeeeeee e 76,77
Dust Delete/Copy Stamp Tool Palette..............eevveeiiiiiiiiiiiiiiiiiieeeeeeee, 76
Dust Erasure Processing
Automatic Dust Erasure Processing .......ccccooveevvvieeeiiiiiiiieieeeeeeeinns 76
Dust Delete/Copy Stamp Tool Palette ........................., 76
Image Correction (Copy Stamp Function) ..........cccccccvvuiivnivinnnnnn, 80
Manual Dust Erasure (Repair Function) ..................................... 78
Dynamic RanNQe .......cooiiiiiiieeecien e 51, 60
E
Edit Image WindOW.........coovrriiiiiciiieee e Adjusting
EditiNg. .o 137
Enlarged Display (Preview Window) .........cccuvvvveeeiiiiiiiiieieee e, 15
EOS UL .ot 9
F
FIter EffECt ... 51
G
General Settings (Preferences)......ccccvveiiiiiiiiiiee e 126
GPS MATK ...t e e e e e e e 134
Grid LINES oo ———— 19
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H
HDR (High Dynamic Range) Images........ccccccceeunuirneiiiniiiiiiivnnennns 98
Highlight Area Warning Indicator ... 20
Histogram Palette ... 14
HUEB o 42,61, 62
|
[CC ProfileS..cceie ettt 135
Image INformMation .............c.uuuuiiiiiiiiii e 34
Image Marks (Image Frame Information) ..........ccoocciiieiiiiiinniiinnn. 134
Image processing (Preferences)........ccoocvveieeeiiiiiiiiciiieee e 127
Image Quality
Noise RedUCHON ........oooiiiiiiiiiiiiiiii 63
J
| L [ 4= Lo = TP 41,135
L
Lens Aberration Correction...........ccoooooeeeiiii 68
Lens aberration correction mark ............cccoooiioiiiiiiiiiis 134
LNl e 52
Loading and Pasting (Applying) ReCIiPes .......ccccceeeiiiiiiiiian, 88
Luminance Noise Reduction ............ooouviciiiiiiiiieccn e, 63
M
=Y A T [0 S 11
Main Window (Multi-layout)..............eeeeiiiiiiii e 17
Main Window (Thumbnail Layout) ...........cccciiieiiiiiiiiiieee 11
Manual Dust Erasure (Repair FUNction) ..........ccccceeeeiiiiiiiinee e 78
MONOCNIOME ... 50
Filter Effect ... 51
TonING €ffeCt....cii i 51
Move Or CopY FOIErS.......cooiiiiiiiiieeee e 37
Move Or COPY IMaGES......couiiiiiiiiiiiiieee e 36
Multi-FuNCtion Preview...........oooooiiiii e 22
MUR-IQYOUL. ... 17
Multiple image display mark...........oooooiiiiiiiies 134
N
Navigator Palette ... 16

NOISE REAUCHION ... 63
o
Organize IMages .....coooeeiieiieeee et 36
Organizing IMagES .......uuviiieeeeiiiiieeeee e 36
Delete IMagesS......cooo v 36
Move or Copy Folders.........ccccoooeiii 37
Move Or COPY IMAGES .......uuiiiiieeiiiiiiiiiiee e 36
Register Folders as Bookmarks ..., 37
P
Palettes
Display Method of Palettes ............ccuuveeeiiiiiiiiiii e, 25
Rearranging Palettes ... 25
Perceptual ...... .o 136
Peripheral lllumination Correction .........cccccceeiiiiiiiiiiiiiiii e, 69
Personal White Balance ...........ccccoooiiiiiee 113
PIcture StYIE .....e 44
Picture Style File...........ueiieeeei e 46
PN e e e e e 18
Pinned image setting mark ... 134
PreferenCes ... e 126
Color Management ..........oooiiiiiiiiiiee e 129
General SettiNgS .......eeeeiiiiiiiieeeeeeee e 126
IMAagEe PrOCESSING....ciieeiiiiiii i i e e e e et e e e e e e e e e e eeeaeanaas 127
View Settings ...ccoooiiiiiicciecce e 130
Preview Control Panel ... 18
Preview Display Ar€a ............ccuuuiuuiiiiiiiiiiiiiiiieiiieeieeeeeeeeeeeeeeeeeeeeeeeeees 17
Preview WINAOW ...t e e e eeeas 15
Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 110
Printing One Sheet of Paper ... 108
Printing with Shooting Information (Detailed Setting Printing) .... 109
Printing One Sheet of Paper...........coovviiiiiiii e 108
Printing with Shooting Information (Detailed Setting Printing)........... 109
Q
Quick CheCk WINAOW .........ovviiiiieiiiiiiiieeeee e 28
QUItING DPP ... e e e 26
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R
= 1] o TR 30, 31
RAtING MACK.......oiiiiiii e 134
L A [ =T T 40, 135
Re-Adjusting an Image .......coooiiiiiii e 85
RECIPE ... e ——— 86, 135
ReCIipe File ... 86
Re-Editing an Image ... 85
Registering Folders as BooKmarks ............cccuvviiiiiiiiiiiiiiie e 37
Remote ShOOtiNG ... 120
Rename WindOW........cooooii e 118
Rendering Intent (Matching Method) ..........ccccvvviiiiiiiiiiiiiiiieeeeeeeee, 136
Repair (Manual Dust Erasure) ..o 78
Rotate Images. ..., 11
S
SaAtUrAtION. ... 42.61, 62
Save

Batch Convert/Save Images (Batch Process).........cccccceennnnnee 115

RS T= Y 83

SV A S e e ettt bttt aeteeeeneneneeeeeas 83
SAVE A 83
SaVviNg RECIPES ...oooviiiiiiiiii 87
SeCOoNd WINAOWS .....ccooiiiiiiiiiiiee e e e e e 23
Select IMages .....oooovvviiiiii . 11, 28, 90
Shadow Area Warning Indicator ............ccccoviiiiiiiiiiiieceee e 20
SAIPNESS ...t 54,75
Shooting Information Display ...........ccceeeeeiiiiiiiiii e 21, 34
Single Image Display ... 33
Single Image Display of RAW and JPEG Image .....................ooooo. 33
Soft-Proof Colors Function...........cccoovvi 82
Sorting Images

L0 0 1=Tor 1 0 F= 1 16 30, 31

= 1] T 1= T 30, 31
SRGB ... e aaaae s 136
Starting UP DPP . 8
Supported IMages.........oooovviiii 3

Synchronization (Preview WiNdOW) ...........cccciiiieiiiiiiiiieeeee e 89
SYNCIroNiZE IMAJES .......uuiiiiiieiiiiieee et 89
Synchronize Preview Window ...........coooiiiiiiiiiiiciiiccecccees 89
System Requirements ..., 3
T
Thumbnail Display (Filter/Sort Function) ...........cceeeeviiiiiiiiiiiiee e 13
Thumbnail Display (Main WINAOW) .........cooueiiiiiiiiiiiiiieeeeiiiieeeee e 11
Change the Display ... 11
Thumbnail Display (Multi-layout) ... 17
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 90
Thumbnail Display Ar€a .........cooeueuiiiii e 17
Thumbnail LayOut...........eiiiiiiccs e 11
Thumbnails Control Panel ..............cccceii 12
TIFF IMAge .cccoeeiieiieeeeeeeeee e 41,135
TONE CUMNVE ... 135
Toning effeCt.. ... 51
Tool Palette .....oooveieiieeeee 42
Basic Adjustment Tool Palette ............ccoovviiiiiiiiicici e, 43
Color Adjustment Tool Palette ... 61
Detailed Adjustment Tool Palette............coovviiiiiiiiiii, 63
Dust Delete/Copy Stamp Tool Palette ...........ccccveeeeeeiiiiiiiiiieeen. 76
Lens Correction Tool Palette ... 68
Settings Tool Palette...........evviiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeee 81
Tone Adjustment Tool Palette..........ccccoooiiiiiiis 56
Trimming/Angle Adjustment Tool Palette............ccccccuvveniiniinnnnnnns 65
10T o = T PP 11
Transfer
Batch Transfer Images to Image Editing Software ................... 117
Transfer an Image to Photoshop ..., 105
Transfer an Image to Photoshop................ccc 105
Trimming (Cropping) range ........cccoeeeiieeieeee e, 134
Trimming/Angle Adjustment Tool Palette ... 65
Trimming/Angle Adjustment Window............coocciiiiiiiiiiiiiiiiiiieeeeeee 65
U
Unsaved editing content mark .............ccccooiiiiiiiiiiiieeeeeeeee 134
UNSharp Mask ......uuuiiiiiciieecee e e 55
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v

View Settings (Preferences) ... 130

Viewing Images in the Main Window (Thumbnail Layout) .................. 11

W

White BalanCe.......c.oooviiiiiiiiiiiiiiee e 46
Click White BalanCe .......coouoeeeeeeeee e 47,57
(7o) (o] gl =Y 0] o1=T =1 (1] (P 48
Personal White Balance ... 113

Wide Gamut RGB ........coooiiiiiiiii e 136

WOrK COlOr SPACE......uuuuiiuuiiiiiiiiiiiitiiittiierearaaer s aseraaerasseseerarrrrne 81
Color Management.........ooooiiiiiiiiiee e 129

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Macintosh and Mac OS are trademarks of Apple Inc., registered in the
U.S. and other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
All other trademarks are the property of their respective owners.
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